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EDITORIAL
This magazine was created using :

Welcome to the last issue of Full Circle.

T

he last of 2011 that is. It's another bumper issue this month with a little bit of
everything: make a persistent USB stick, create a backup with SpiderOak, LibreOffice
Calc, making 11.10 look 'classic', and how to connect to IRC. Not only that but Ubuntu
Games has grown to two articles each month, so please welcome Riku and Jennifer as
our regular gamers. Charles has taken over the Linux Labs column and, this month, shows you
how to install XBMC (Xbox Media Centre). I've also added a few other new bits to this issue, but
I'll let you find them yourself.
Robin 'Mr. Podcast' Catling makes an appearance with his review of Puppy Linux. Now based
on Lucid Lynx, Puppy is even more relevant to us than in previous incarnations, and if you
haven't tried it yet on your old hardware I definitely recommend it. It's small, lightning fast, and
fully equipped for that aging hardware you have lying around gathering dust.
The majority of people voted that they would attend, or would be interested in attending,
an FCM IRC meeting each month. I'll try and set something up for January/February 2012 if
possible. I'll announce a date either in FCM#57 or online via our website mailing list, Facebook,
and Google+, so stay tuned!
Don't forget to check out the questionnaire for next month. Fill it in and you could be in
with a chance to win 100GB of cloud space courtesy of SpiderOak. We'll also pick winners from
Twitter and Facebook. See the 'I Think' results pages for more info.
All the best, keep in touch, and I'll see you all in 2012!

Ronnie

Full Circle Podcast
Released monthly, each episode
covers all the latest Ubuntu news,
opinions, reviews, interviews and
listener feedback. The Side-Pod is
a new addition, it's an extra
(irregular) short-form podcast
which is intended to be a branch
of the main podcast. It's
somewhere to put all the general
technology and non-Ubuntu stuff
that doesn’t fit in the main
podcast.
Hosts:
Robin Catling
Ed Hewitt
Dave Wilkins
http://fullcirclemagazine.org

ronnie@fullcirclemagazine.org

full circle magazine #56
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LINUX NEWS
Ubuntu 11.10 To Power
New PC Line

Gnome 3 Shell Forked
As Cinnamon

US PC maker CTL [has] announced a
new line of Ubuntu-powered
computers, beginning with a
notebook called the MB40U.

So why has Gnome 3 been forked
[...] ? [It] comes with a completely
new way of using the desktop that
not everyone will be comfortable
with.

Android Drivers To Be
Included In Linux 3.3
Kernel

Ubuntu Kills Java

Oracle’s Sun Java JDK packages are
to be removed from the Ubuntu
partner repositories and disabled on
Android drivers are users systems after Larry Ellison
returning to the
ruled that the retiring the
Linux kernel. Kernel ‘Operating System Distributor License
maintainer Greg
for Java, means Canonical no longer
Kroah-Hartman has have permission to use it.
retrieved the
Android drivers removed from the The change will affect Ubuntu
staging area of Linux 2.6.33 in the
10.04, 10.10 and 11.04 users only.
spring of 2010 and put them back
Those who have ‘sun-java-6' package
into his development branch for
installed on their system will see it
version 3.3 of the Linux kernel.
removed via a future software

update.
The plan is for a Linux 3.3 kernel to
be able to boot on an Android
Source: fudzilla.com
A Dramatic Increase in Speed
device without further patches –
With the release of Linux Mint 12,
although not all Android patches
the Linux Mint developers created
Equipped with up to 8GB of
are being automatically carried
FC Notifier Update
memory, a second-generation Intel extensions for Gnome 3 that
over to the main development
brought back a lot of the Gnome 2Core i3, i5, or i7 processor, DDR3
branch. For example, the WakeLock The Full Circle Notifier is still at
style UIs however, there is a limit
memory, Bluetooth, and
code, which helps Android devices'
1.0.2, but the PPA has been
to how far one can go with just
multimedia buttons, the 14.1-inch
batteries last longer but is not
updated for Oneric. FCN is a small
extensions. So the Gnome 3 has
MB40U weighs just 4.85 pounds
necessary for booting, is not
application that sits in your
and offers a battery life of up to six been forked, with the intention of included.
system tray and will announce
creating a new desktop similar to
hours. Expanded storage space is
issue/podcast releases, and can
Gnome 2 but built on top of the
available through the use of ESource: h-online.com
be set to download them too!For
technically superior Gnome 3.
SATA.
more info, see the FCN Google
Group: http://goo.gl/4Ob4
Source: devworks.thinkdigit.com
Source: pcworld.com
full circle magazine #56
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COMMAND & CONQUER

VIM : Advanced Editing

Written by Lucas Westermann

D

ue to the large interest
presented in this topic
by a reader, I've decided
to write another one or
two articles on Vim (including this
one). This month I'll be focusing on
a tangible example (file can be
found here:
http://pastebin.com/EqrfBFhF). I'll
cover using visual block mode,
some tricks for commenting large
numbers of lines, a couple of tricks
for using the mouse, and
copying/pasting to/from external
programs from/to Vim. If you're
familiar with all of these topics, you
can safely skip this article.
Before we begin, I will briefly
explain what an abundant number
is, so that everyone can roughly
follow the script. An abundant
number is a number for which the
sum of all factors (a factor is a
number which divides a value
without a remainder) is greater
than the number itself. Example:
The factors of 12 are: 1,2,3,4,6; the
sum of the factors: 1+2+3+4+6=16;
16>12. What the script does is
simply calculate which numbers
(from a supplied range of numbers)

are abundant, and which are not.
The function is part of my solution
to an Euler Project problem.
In order to follow the article, I'd
highly recommend opening a copy
of the file from Pastebin in Vim (or
GVim) so you can work along.

Area 1 (Commenting)
For those of you who are
programmers, you'll be familiar
with the concept of commenting
out all code besides a small
segment you want to test, when
things aren't working. My approach
to doing this is to use Visual Block
Mode. The steps are as follows
(from the beginning of the first line
you want to comment):

full circle magazine #56

<ctrl>+[v]; [j];
<shift>+[i], [#]; [Esc]

The first step enters Visual
Block mode, the j key acts as a
down arrow key, and <shift>+[i]
enters insert mode for all selected
lines. After these steps, you then
hit the key for the comment
symbol (in Python's case it's the
octothorpe, a.k.a. hash symbol). For
uncommenting, check Area 2 for
Deleting in Visual Block Mode.
The reader who contacted me
offered the following script to do
the same:
" COMMENTING OUT A #
CHARACTER IN BASH SCRIPTS
function! AddDelBashComment()

5

let char=getline('.')[0]
if char == "#"
s/^#//g
else
s/^/#/g
endif
endfunction
vmap <silent> # :call
AddDelBashComment()<CR>

This script has to be added to
your .vimrc. Once it has been
added, you can call it in the
following way (same process for
commenting and uncommenting):
<ctrl>+[v]//[v]//[V]; [j];
[#]

As you can see, the only thing
you save by doing this is entering
and exiting insert mode (and
possibly having to press the control

contents ^
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key). I've included this script for the
sake of those for whom every
keystroke counts. You will need to
adjust the substitute lines for each
comment character you frequently
use. For SQL you would replace if
char == “#” with if char == “-” and
s/^#//g with s/^--//g (same for the
other substitution command). You
must also replace the octothorpe
in the vmap line, otherwise you'll
be using the same key for multiple
functions.

Area 2 (Visual Block
Mode)
Since we covered inserting in
Visual Block Mode in Area 1, I will
not repeat it in this area.

Block mode:
Section of a line:
[v]; [h]//[j]//[k]//[l]; [y];
[h]//[j]//[k]//[l];
<ctrl>+[v];
[h]//[j]//[k]//[l];
<shift>+[i]//<shift>+[a];
<ctrl>+[r]+[“]; [Esc]

<shift>+[i] inserts at the start of
the line/selection, and <shift>+[a]
appends to the end of the
line/selection.
Copying and pasting an entire
line in multiple lines doesn't work
with this method (at least not for
me). As such, we won't cover it. As
a side-note: <ctrl>+[r]+[“] works in
any insert mode and pastes the
contents of the Vim register (the
local clipboard).

Deleting in Visual Block Mode:
<ctrl>+[v];
[j]//[h]//[l]//[k];
[d]//[x]//[X]

Which key you use in the second
step is entirely dependent upon
which direction you want to go
(down, left, right, up, respectively).
The key in the last step is entirely
up to you, they all do the same.
Yanking (copying) text in Visual

Area 3 (Mouse usage)
Just a brief tip: If you want to
highlight something in Vim using
Visual Block Mode, hold
<shift>+<alt> as you select.

Area 4 (Copying and
Pasting to/from
external programs)
full circle magazine #56

You may have noticed that the
yank and paste methods work only
within Vim. To copy text from Vim
to another program (firefox, for
example), you can select the text
with the mouse and use the
middle-mouse button paste. If,
however, you are at another
computer that runs a different
operating system (or lacks that
function), you can copy text to the
system clipboard with:
[v]//[V]; [y];
[h]//[j]//[k]//[l]; [“][+][y]

A quick explanation: you select
the text you want (first two steps)
and then you hit the quotation
marks key (on German keyboards
it's <shift>+[2]), and then the plus
key, and then the y key. Do this one
after the other, not all at once.
Then to paste in the external
program, just use <ctrl>+[v], as per
usual.
Pasting:
[“][+][p]

That's it. Press those 3 keys and
it will paste the clipboard onto the
line you have selected (so you may
need to start a new line if that's
what you want).
6

“

To copy text from
Vim to another
program [...] select
the text with the
mouse and use the
middle-mouse button
paste.

You can also set the clipboard
to autoselect, which should
automatically copy to the system
clipboard when you highlight
something, and automatically
paste from the clipboard when you
press the middle-mouse button.

Area 5 (Extra tips)
Syntax Highlighting:
You can enable syntax
highlighting in Vim by using:
:set syntax=on (in Vim
itself)

or
syntax enable (in your
.vimrc)

Hide Vim in the terminal:
<ctrl>+[z] will suspend a task
contents ^
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into the background (tested in Zsh
and Bash). Once you've suspended
a task, you can re-open it using the
command fg in the terminal.
In keypresses:
<ctrl>+[z]; [f][g][Enter]

Encrypt files with Vim:
vim x <file name>

This command will prompt you
for an encryption key before you
view the file (if the file is
empty/new, it will then store the
password you enter).
Viewing History:

This will save the file with sudo
rights (in case you open a system
file and made changes before
realizing you had no rights to save
the file). Vim will ask you
afterwards if it ought to re-load
the file, which you'll want to do.
Vimdiff:
Vimdiff is an extended version
of Vim where you can open
multiple files to compare them.
Usage:
vimdiff file1 file2

For horizontal split:
vimdiff o file1 file2

[q][:]

For more information:
This will pull up a list of past
http://vimdoc.sourceforge.net/htm
commands. You can enter the
ldoc/diff.html
number from the list in order to
pull up the command, or enter [:][q]
Specify that a Tab is 4 spaces
to quit the list.
(useful for Python users):
Execute system commands from
within Vim:

set tabstop=4

[!](command)

Write this into your .vimrc, and
any time you press the tab key, it
will actually insert up to 4 spaces.

An example:
:w !sudo tee %

This should be more than
full circle magazine #56

enough to keep everyone busy
until next month. If you have any
questions, comments, or requests,
feel free to email me at
lswest34@gmail.com. If you do
email me, please be sure to include
“C&C” or “FCM” in the subject, so
that I don't overlook it.
My .vimrc file:
http://pastebin.com/wv260CJk
I hope you've found this article
to be interesting. I plan to continue
along this path next month. If you
have any questions, comments, or
suggestions, feel free to email me
at lswest34@gmail.com. If you do
email me, please include “FCM” or
“C&C” (or, as a regular expression:
[fFcC][cC&][mMcC]) in the subject
header.

The Ubuntu Podcast covers all the
latest news and issues facing
Ubuntu Linux users and Free
Software fans in general. The
show appeals to the newest user
and the oldest coder. Our
discussions cover the
development of Ubuntu but aren’t
overly technical. We are lucky
enough to have some great guests
on the show, telling us first hand
about the latest exciting
developments they are working
on, in a way that we can all
understand! We also talk about
the Ubuntu community and what it
gets up to.
The show is presented by
members of the UK’s Ubuntu Linux
community. Because it is covered
by the Ubuntu Code of Conduct it
is suitable for all.

Lucas has learned all he knows from
repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: lswest34@gmail.com.

7

The show is broadcast live every
fortnight on a Tuesday evening
(British time) and is available for
download the following day.
podcast.ubuntu-uk.org
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HOW-TO

Make 11.10 Look 'Classic'

Written by Erick Lance Brunzell

NOTE: Don’t kernel panic,
programmers, Greg will be back
with more Python next month.

B

efore beginning, please
understand that I'm no
genius, far from it. My
focus has been on Classic
(with no effects) only because I've
never cared for Compiz anyway,
and, from what I've read, it seems
to be difficult to get it to run in a
classic Oneiric DE. So, if you want
Compiz this is NOT for you, sorry.
However I do hope someone else
will be able to expand on this.
I've tested this quite a bit, but
only with fresh, fully updated
Ubuntu Oneiric installs. Your
mileage may vary with installations
that have other underlying
problems.
Important warning: Many of the
changes made here can and will
break Unity, so I highly recommend
first testing this either in a virtual
machine or a multi-boot. I
personally prefer an actual multiboot but that's just a matter of
choice.

Another safe way to try this
would be to create a new user
account with administrative rights,
that way the configuration files you
change will affect only that new
account. Then, if you decide to
apply the changes to your original
user account, the needed PPA's and
packages will already be installed,
so you'll need to complete only
those steps needed to obtain the
desired configuration. And then
the new user account could be
deleted.

problem with that, I just prefer the
CLI.

First, take a look below at what I
ended up with, and then I'll explain
how I got there.

Also, if I didn't include "sudo" in
the command, then it's not needed,
You'll notice that I prefer only
and in rare instances may result in
one panel at the bottom. I realize
changed permissions, so please just some may want two panels, or one
copy and paste!
at the top only, it's purely a matter
of preference.
Note: If a "step" can be
performed using Ubuntu Tweak
You also need to know that you
and/or 'gnome-tweak-tool', I will
must now hold down either Alt key
mention it briefly at the end of that while right-clicking on a panel or
individual step.
applet to be able to edit panel
preferences or to

This guide is almost totally
reliant on copy and pasting
commands into gnome-terminal.
Why? Quite simply, not all of this
can be completed using GUI tools
like Ubuntu Tweak or 'gnometweak-tool', and installing 'gnometweak-tool' results in installing a
large number of unneeded
packages including 'gnome-shell',
and my only concern is getting a
"classic w/o effects" desktop
environment (DE) running
efficiently. Should someone care to
use either Ubuntu Tweak or
'gnome-tweak-tool', I have no
full circle magazine #56
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add/edit/move/remove more
applets. That was an intentional
move by the Gnome devs to
prevent people from
unintentionally breaking things.
And you also can't just add
application applets by right-clicking
them and selecting "add to panel"
anymore. You must now open the
"add-to-panel" window and select
Application Launcher > Forward,
then the window changes and you
can click on the "bullet" to the left
of each category to display and add
any app in the menu to the panel:

But let’s also look at Panel
Properties settings. Note here that
in Panel Properties > Background
I've found that 'Solid color' > Color

> Color name #3F3E39 / Style >
Opaque results in vastly improved
appearance of the Workspace
Switcher, a picture's worth a
thousand words:

Now it's time to move on to how
sudo aptget install
I got there, one step at a time.

Step #1
We simply need to install
'gnome-session-fallback' - which is
already in the Ubuntu repos:
sudo aptget install gnome
sessionfallback

Step #2
You'd quickly find that
'indicator-applet', 'indicator-appletcomplete', and 'indicator-appletsession' are lacking in "Add to
panel". You'll really need either
'indicator-applet' or 'indicatorTo be perfectly honest, I now
applet-complete' to display some
forget I'm even using Gnome 3
of the notifications such as mail,
most of the time other than
the hardware sensors and/or
learning the new keyboard
system monitor indicators, and the
shortcuts which still confuse me. I
update-notifier. (I personally only
do know that Ctrl + Alt + T launches use 'indicator-applet', but we all
gnome-terminal, but even it can be have individual preferences). So we
fiddly. I suspect that the new
need to install Jason Conti's PPA
keybindings are truly designed for
(https://launchpad.net/~jconti/+arc
Gnome Shell, not the "fallback" DE, hive/gnome3), and our first
which I expect to see disappear
additional packages:
altogether eventually (hopefully
not before the release of Precise
sudo addaptrepository
ppa:jconti/gnome3
Pangolin, though).
sudo aptget update

full circle magazine #56
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indicatorapplet indicator
appletcomplete indicator
appletsession

When that is complete, it's time
to take your first look at the new
"classic" DE by simply logging out,
then clicking on the "gear" to the
right of your user name on the
login screen, selecting Classic (No
effects), entering your password,
and logging back in. You'll
hopefully see this:

Now, before continuing, please
understand that all of these
additional steps are optional. No
two people want the exact same
look, feel, or function out of a DE!
This is just what I wanted. Pick and
contents ^
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choose to suit your own desires.

Step #3
I quickly realized that the purple
background of the terminal was
killing my eyes, so, in terminal, I
clicked Edit > Profile Preferences >
Colors, and unticked the "Use
colors from system theme" box.
Then, in the same window, I clicked
on the color block next to
"Background color", and used the
eyedropper to set the background
to white. Ahhhh, much easier on
the eyes.

Step #4
I found the screen lock thing
very annoying, I live alone and
don't like having to enter my
password every time the screen"blanker" activates. So you can just
go to System Tools > System
Settings > Screen, and select Lock =
Off. (I call it a screen-"blanker",
mostly as a joke, because it hardly
resembles a screensaver any more).

screen-"blanker" activate while
trying to watch videos or such. In
Gnome 2, I used to be able to use
'gnome-inhibit-applet', but it's not
available in Gnome 3. No worries, I
found a very good replacement,
Caffeine:

Should you choose to install it
you can set up Caffeine by going to
Other > Caffeine preferences.
Installation is easy:

https://launchpad.net/~caffeinedevelopers/+archive/ppa

sudo aptget update

In my original screenshot, the
caffeine applet shows up next to
the indicator-applet. I find it to be a
sweet replacement for the old
'gnome-inhibit-applet'. Once
installed and set up, it allows you
to "inhibit" the screen-"blanking", I
think a picture is worth a thousand
words - so here:

Note: This works equally well in
Unity.

sudo addaptrepository
ppa:caffeinedevelopers/ppa

sudo aptget install caffeine

Step #6
In Unity, the updatenotifications now show up in the
Launcher, but, without the
Launcher, we now get no
persistent update notifications.
Still, no worries, I got it to show up
in either 'indicator-applet' or
'indicator-applet-complete' in
gnome-panel by running the
command:
gsettings set
com.ubuntu.updatenotifier
autolaunch false

Step #5

You can revert that by running:
gsettings set
com.ubuntu.updatenotifier
autolaunch true

Even after setting Lock to Off, I
found it annoying to have the
full circle magazine #56
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Step #7
I really liked using either
'gnome-sensors-applet' or
'computertemp' to display system
temps in the panel, but again
they're not available with Gnome 3.
Again no worries, Hardware
Sensors Indicator comes to the
rescue:
https://launchpad.net/~alexmurray
/+archive/indicator-sensors
More about that here:
http://ubuntuforums.org/showpos
t.php?p=11492701&postcount=4.
To install, just run these three
commands:
sudo addaptrepository
ppa:alexmurray/indicator
sensors
sudo aptget update
sudo aptget install
indicatorsensors

It then shows up in System
Tools > Hardware Sensors
Indicator. After launching it the
first time, you must click on the
new "applet" which just says "No
active sensors", and click on
contents ^
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Preferences. From there you can
select which sensors to display, and
other options.

Step #8
It's also sometimes nice to
display CPU and memory usage in
the panel, so here's System
Monitor Indicator:
https://launchpad.net/indicatorsysmonitor

I found the overlay-scrollbars to
be inconsistent and annoying in the
classic DE, so I removed them, but
that was totally a matter of
preference, and this is one of those
steps that really seems to
somewhat break Unity! Should you
want to remove them, run:
sudo aptget purge
liboverlayscrollbar0.20
liboverlayscrollbar30.20
overlayscrollbar

Note: You'll likely have to reboot
More about it here:
http://ubuntuforums.org/showpost for that change to fully take effect.
.php?p=11473552&postcount=208.
To install just run these three
commands:
sudo addaptrepository
ppa:alexeftimie/ppa

Step #10

At this point I decided the
window-management buttons
really needed to be back on the
right so I ran:

sudo aptget update
sudo aptget install
indicatorsysmonitor

It then shows up in Accessories
> System monitor indicator. Do not
confuse it with System Monitor in
System Tools. I think setting it up is
almost self explanatory.

Step #9

gconftool2 set
"/apps/metacity/general/butto
n_layout" type string
":minimize,maximize,close"

Note: to restore the defaults
run:
gconftool2 set
"/apps/metacity/general/butto
n_layout" type string
"close,minimize,maximize:"

full circle magazine #56

Note: This step (#10) can also
be performed using Ubuntu Tweak.

Step #11
At this point, I'm fairly happy,
but the scrollbar color is hard on
my eyes. It's like trying to
differentiate between two shades
of white. I'd really prefer having
the scrollbars match the dark gray
panel or window title-bar with a
white background, but I haven't
been able to figure that out yet.
The best alternative I've found so
far is changing the metacity and
gtk themes this way:
sudo addaptrepository
ppa:webupd8team/themes
sudo aptget update
sudo aptget install shiki
colorsmetacitytheme
zukitwodarkgtktheme
gconftool2 s type string
/apps/metacity/general/theme
ShikiColorsMetacity
gsettings set
org.gnome.desktop.interface
gtktheme ZukitwoDark

I found that fairly pleasing to
my eyes (it also replaced the
drastic orange with a nice grayish11

blue, and I like the "retro" look of
the window management buttons),
but if you should decide to revert
to the default Ambiance themes
just run:
gconftool2 s type string
/apps/metacity/general/theme
Ambiance
gsettings set
org.gnome.desktop.interface
gtktheme Ambiance

Note: Both Ubuntu Tweak and
'gnome-tweak-tool' can be used for
applying themes, but NOT
installing themes.
I'm very open to suggestions
about theming - this is simply the
best combo I've come up with so
far.

Step #12
I also dislike the missing menu
and button icons, so I run:
gsettings set
org.gnome.desktop.interface
menushaveicons true
gsettings set
org.gnome.desktop.interface
buttonshaveicons true

Note: This step (#12) can also
contents ^
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be performed using Ubuntu Tweak.

either reboot, or log out and log
back in. When you get back to a
blank DE background, decide what
Step #13
you want displayed. (Hint, the
This one is the hardest for me to "true" or "false" at the end of these
commands is the key):
explain. By default the Oneiric
desktop is set to NOT display any
icons, but it's possible for the
desktop to display any combination
of these icons/"actors":
Computer
(computericonvisible)
Home
(homeiconvisible)
Network
(networkiconvisible)
Trash
(trashiconvisible)

To show the Computer icon run:
gsettings set
org.gnome.nautilus.desktop
computericonvisible true

To hide the Computer icon run:
gsettings set
org.gnome.nautilus.desktop
computericonvisible false

gsettings set
org.gnome.nautilus.desktop
volumesvisible true

To hide Mounted Volumes run:
gsettings set
org.gnome.nautilus.desktop
volumesvisible false

gsettings set
org.gnome.nautilus.desktop
homeiconvisible true

Step #14

To hide the Home icon run:

But, to do so, you must first set
the "stage" by running:

To show the Network icon run:

After running that command,

To show Mounted Volumes run:

To show the Home icon run:

gsettings set
org.gnome.nautilus.desktop
homeiconvisible false

But that only sets the stage for
the actors, now you must decide
which actors you want on the
stage. You're now the director.

gsettings set
org.gnome.nautilus.desktop
trashiconvisible false

Note: This step can also be
performed using either Ubuntu
Tweak or 'gnome-tweak-tool'.

Mounted volumes
(volumesvisible)

gsettings set
org.gnome.desktop.background
showdesktopicons true

To hide the Trash icon run:

You may or may not find that
you need to disable the Firefox
and/or Thunderbird global menu
add-ons. It seems to depend on the
panel configuration, but I'm not
quite sure. To do so in Firefox, just
go to Tools > Add-ons > Global
Menu Bar integration, and select
Disable. You'll then be prompted
to restart Firefox. I don't use
Thunderbird, so I can't be sure of
the specific procedure with it, but
I'd think it's similar.
That's it! I hope others will
share their favorite Oneiric classic
tips and tricks. Maybe someone
can even share how they got classic
to run with Compiz since that's not
my thing.

gsettings set
org.gnome.nautilus.desktop
networkiconvisible true

To hide the Network icon run:
gsettings set
org.gnome.nautilus.desktop
networkiconvisible false

To show the Trash icon run:
gsettings set
org.gnome.nautilus.desktop
trashiconvisible true
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LibreOffice - Part 10

Written by Elmer Perry

n part 8 of this series, we
began our work in Calc, and
created and formatted an
income section for a budget
worksheet. Last month we began
our discussion of functions and
formulas. In this part, we will
continue working on our budget
worksheet, and use formulas and
functions to do calculations in it.

Setting Up the Assets
Section

Center Cells). In cell D2, enter
“Type”. Merge and center this cell
with E2. Enter “Beginning” and
“Ending” in cells F2 and G2
respectively. In cell D3, enter
“Period Income Total,” and merge it
with cell E3 (Format > Merge Cells
> Merge Cells). In rows D4-D9,
enter the following text in order:
Checking Balance, Savings Transfer,
Total Expendable, Savings Balance,
Retirement Balance, Gross Assets.
After entering the text in the cells,
go back and merge these cells with
their adjacent cell in column E (i.e.
merge D4 with E4, D5 with E5...).

Initial Calculations for
Asset Section

If you recall, we had set up a
section that contained all of our
income items in columns A and B.
We will begin our Assets section in
cell D1. Move to that cell and enter
“Assets” in it. Select cells D1-G1,
and merge and center the cells
(Format > Merge Cells > Merge and

In cell F1, we will place our first
calculation using the SUM()
function. For this cell we need to
total the numbers of column B in
our Income section. Enter this
formula in cell F3:

If your Income section contains
more or less income items, adjust
the cell reference given to the
SUM() function. If you pull out a
calculator and add up the numbers,
you will find you get the same
number as the total calculated by
LibreOffice Calc.

Enter amounts for the Savings
Balance and Retirement Balance in
cells F7 and F8. Select cell F9, and
click the sum button in the formula
toolbar. Notice that, once again,
Calc has selected the two numbers
above it, but for an accurate total
of the Gross Assets, we need to
include the Total Expendable
In cells F4 and F5, enter
amount. Left click and drag to
amounts for the Checking Balance
select the three cells. You should
and Savings Transfer. In cell F6, we now see the corrected range in the
will need to sum the three amounts SUM() function. Press Enter to
above for the Total Expendable
accept.
item, but this time, we will use a
different method. Select cell F6
and click on the sum button
(shown left) in the formula
toolbar. You will notice that
LibreOffice automatically finds the
three amounts above and creates a
SUM() function formula with the
range inside. Press Enter to accept
the range.

Setting Up the
Expenses Section
We will come back to the Assets
section to do some more
calculations once we get the
Expenses section set up. In cell
A11, enter “Expenses”. Merge and

=SUM(B3:B6)

This formula uses the SUM()
function to total the numbers
entered in cells B3, B4, B5, and B6.
full circle magazine #56
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center the cells A11-G11. In cell
A12-E12, enter the following text
in the cells: Type, Due, Amt Due,
Amt Pay, and Notes. Merge and
center the cells E12-G12. This
becomes our header row for this
section.
In cell A13, enter “Savings”, and
in cell A14 enter “Retirement”.
These two expenses will represent
deposits into these two accounts,
and we will use them in our final
calculations in the Assets section.
Beginning with cell A15, and going
down the A column, enter other
expenses like Food, Fuel,
Mortgage, Phone, etc. In columns B
and C, enter due dates and due
amounts for all the items you
entered in the Expenses section.
Select a few of the items and put
payment amounts in the D column.
Merge the E, F, and G rows for each
of the items.

Formulas in the
Expenses Section
In the cell below the last item
(column A), enter “Total
Expenses:”, and merge it with
column B on that row. Select the
cell in column C for that row. Click
the sum button in the formula

toolbar. Calc should select all the
amounts in the Amt Due column.
Press Enter. In the D column of the
same row, type “Total Payments”
and merge it with column E on the
same row. Select column F of the
same row and click the sum button
on the formula toolbar. This time
Calc jumps all the way up to the
last amount in our Assets section,
but this is not what we want. This
happens because this is the first
number Calc found in the column.
Select the numbers in the Amt Pay
column of the section to change
the range. Press Enter.

savings account, we need to take
the beginning total, add the
deposit, and subtract the transfer.
If you put the Savings as your first
item in the Expenses section, the
formula will look like this:

we need. Press Enter.
Our budget spreadsheet is now
complete, but it doesn't look very
pretty. Next time, we will format
our spreadsheet using styles.

=F7+D13F5

For the Retirement ending
balance, we just need to add the
deposit. If you added Retirement
as the second item in the Expenses
section, the formula will be:
=F8+D14

Elmer Perry's history of working, and
programming, computers involves an
Apple IIE, adding some Amiga, a
generous helping of DOS and
Windows, a dash of Unix, and blend
well with Linux and Ubuntu.

Finally, we will make the final
adjustment to the Gross Assets by
summing
the three
numbers
Going back to the Assets
in the G
section, we will use some of the
numbers in the Expenses section to column.
Select G9,
do a few more calculations. Select
and click
cell G6. This is the total for our
the sum
expendable income after all
button in
payments have been made. Enter
the
the formula:
formula
toolbar.
=F6F##
Calc
where ## is the row number where should
the total payments is calculated.
select the
three
For the ending balance on our
numbers

Final Calculations for
the Asset Section
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Backup Strategy - Part 4 : SpiderOak

Written by Allan J. Smithie

I

n previous installments, we've
talked about the features we
want in a Cloud Back-up
service; this time we're going
to try SpiderOak to see how it
measures up. According to the
marketing puff on
www.spideroak.com:

"SpiderOak provides an easy, secure,
andconsolidatedfree online backup,
sync, sharing, access andstorage
solution for Windows, Mac OS X, and
Linux (Ubuntu, Debian, Fedora &
openSUSE)"

Remember this is a hosted
service with its own client software

- built around a particular security
and cross-platform model. You
don't get a choice of storage
locations or hosts.
You can try SpiderOak yourself
on the SpiderOak 2GB Free plan,
which offers 2GB of on-line storage
free for life. This is probably
enough to trial the service, and
maybe store some essentials such
as your unfinished novel and Inbox. The next step is a SpiderOak
Plus Account that goes from 100GB
up to whatever you can afford. The
price is $10 per month per 100GB
increment, or pay yearly and get
the 100GB increment for $100. Be
aware that tipping over 100.1GB is
still the whole $20 a month. I won't
address performance other than to
say that SpiderOak software and
remote storage runs respectably
up and down a domestic
broadband connection for both
backup and restore. That said, I am
not using it to backup an entire
hard drive, only selected folders.

Software
You can install the SpiderOak
full circle magazine #56

client on as many
computers as you
like and you can be
completely crossplatform. Setting
the password for
encryption is built
into the installer,
which is a rapid,
guided process.
SpiderOak
takes data security
very seriously;
data is encrypted
and transmitted
over a secure
connection, a
layered approach using a
combination of 2048-byte RSA and
256-bit AES which encrypts the file
and folder names, so even
SpiderOak employees can't tell
what you have backed up. Of
course, if you forget your
password, nobody can access your
data. A quirk of SpiderOak's
security is that any files you backup
on one machine are visible on any
other machine that uses the same
account (with the same SpiderOak
account password). Perhaps
15

consider one SpiderOak account
for your personal files, with
another account for your family
computers, thus avoiding any
embarrassment.
Decide for yourself whether the
SpiderOak software looks
fashionably 'retro' or just a bit
clunky. There is a lot going on with tabs and, in effect, sub-tabs
grouping functions together.
The Status tab provides plenty
of information regarding
contents ^
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connection, backups, sync and
shares, and your current queue.
The Back Up tab is just a place for
you to specify what files you would
like to include in a backup. Each
category on the selection list
corresponds to a folder on your
computer - even 'Desktop'. The
bottom bar gauges how much of
your cloud storage allocation your
selection will occupy, color-coded
by folder, so you can see what
takes most space.

Sync and Share - either to a
frequency or to a specific day and
hour.

even after months or years.
However, don't confuse backup
with file-sharing. SpiderOak is like
most of the syncing services in that
changes are synchronized instantly
and in real-time, so that any
accidental change you make while
on-line will automatically sync to
the server.

your SpiderOak network. You
choose the source folders,
followed by a destination folder
into which the software should
merge them. SpiderOak will work
out what's the most recent data of
the two sources, and output a list
for your review before it carries
out the merge. This is nothing
radically original so much as an
effective packaging of what we
used to call diff-scripts with Cloud
communications, all wrapped in an
effective user interface.

The View tab is the heart of
defining what is selected for backup down to the file level, along
with the version history.

Version Master

The Schedule tab provides a
simple one-stop control for Backup

SpiderOak understands version
control. Your first backup set is a
full set; for subsequent backups of
the same defined set, only the
incremental changes of the backup
set are transmitted, so it won't
massively compromise your
storage limit to hold several
versions of files. If you do breach
your limit, you can manually delete
old versions. SpiderOak provides
version history with no time limit,
so if you alter or delete a file you
can 'roll back' to an earlier version,
full circle magazine #56

Merge and
Sync
The merge function
is where SpiderOak
scores for ease of use
and utility.
Merge does a onetime merge of all the
files in any folders on
16
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Share

The Sync page is where you set
which folders remain synced
between your computers, where
any number of tools across PC,
Mac, and mobile carry out this kind
of operation reliably these days; it
just happens that SpiderOak is that
bit prettier

It's a much-abused word, these
days; 'share'. Not only does
SpiderOak run across multiple
computers, its public sharing
service is implemented though
"Share Rooms". These are virtual
folders which are passwordprotected, and through which you
can share your data with anyone
you like. A change made to a
defined synchronization set on any
computer running SpiderOak
automatically triggers those
changes to be published to the
share room. Access to the
ShareRoom is in one of two ways:

• by entering your ShareID and
unique RoomKey on the SpiderOak
homepage using the 'Share Login',
or
• by emailing out the Shareroom
link to guests.
SpiderOak creates an on-line
photo album when sharing photos.
Like Dropbox's public links, it works
fine for posting a few selected
images, but it's no substitute for
the full range of gallery tools in
services like Picasa and
Photobucket.

an effective service, with a featurerich client, from a small company just the thing that bigger
companies buy up. Balancing
features against simplicity, it does
cater for most things you need in a
Cloud back-up.

Have a look at the questionaire
for next month's 'I Think' for a
chance to win one of five 100GB
SpiderOak storage packs!

As well as the dedicated clients
for Linux, Mac, Windows, and
Android, there's a browser-based
SpiderOak web-application. You
can't upload files from the browser,
but you can download any file or
whole folder as a zip file, which is
saved in your Downloads folder,
with a date-time stamp appended
to the file-name, giving you muchneeded version control
information.

Conclusion
Place your bets on whether
SpiderOak will be around as an
independent service under its
current name in a few months. It's
full circle magazine #56
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Allan J. Smithie is a journalist and
commentator based in Dubai. His
blog, 'No Expert,' is at:
http://allanjsmithie.wordpress.com
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Create a Persistent USB Stick

Written by Art Shreckengost

ootable flash drives
(often produced by
UNetbootin) offer users
the option of having a
portable operating system (OS).
However, session changes cannot
be saved, nor can the OS ever be
updated. This has proved
problematic, especially in light of
recent Ubuntu updates for security
patches.

documents. Anything changed
during a session is saved back to
the flash drive - unless you indicate
otherwise (an option to ignore
changes is offered).

An option is to use a persistent
flash drive, i.e. a drive designed to
accept changes that are saved for
future use. Unfortunately,
UNetbootin does not offer
persistence yet.

The real curiosity is that it does
load and work via Wine, but
Installer cannot recognize flash
drives unless they are listed by the
Windows letter system, something
Ubuntu (and Linux in general) does
not use. Take my word and don’t
bother using Installer with Wine since the end result is nothing but
disappointment.

Pendrivelinux.com
(www.pendrivelinux.com/universalusb-installer-easy-as-1-2-3/) offers
Universal USB Installer (hereafter
referred to as Installer), and it’s
designed to create persistent Linux
drives that not only boot to live
mode but also save updates and
other changes to a flash drive.
This includes drivers, codecs,
updates, security patches,
programs, music files, and

Installer is unique in that it
doesn’t need installation but
instead works off the desktop icon
(it’s just 900KB), but it has one flaw
in being a Windows-only program.

Bummer. Guess I can’t complain
since it’s a free program, but,
unless you have XP or 7 running in
a VM or dual boot, you’d better
plan on borrowing time off a
friend’s PC.
Fire up the program and you’ll
get a dialog pop-up that doesn’t
full circle magazine #56

look like much until you tick the
box to open what reads like a Linux
family tree. Best as I can figure,
roughly 70 versions are listed here
- ranging from sub-200MB guppies
to 4GB monsters.

Feather Linux, Fedora, Finnix,
FreeDOS, Gentoo, gOS, GParted,
Jolicloud (now JoliOS), Hiren’s
Boot CD, Kaperksy Rescue Disk,
Knoppix, Linux for Kids, Macbuntu,
Mandriva, MCNLive, Panda Safe,
Parted Magic, PCLinuxOS,
Ubuntu is heavily recognized
Peppermint Linux OS, Ping, Pinguy,
with 9.x to 11.10 versions - along
PloP, Puppy Linux (4 versions),
with similar offerings for Xubuntu, Redo Backup, Rin, RIP Linux, Runt,
Lubuntu, Kubuntu, Edubuntu,
Sabayon, Simply Mepis, SLAX,
Remix, Rescue Remix, and Server.
SLiTaz, T(A)ils, TinyCore, Ultimate
Rounding out these mainly
Boot CD, Ultimate Edition Lite,
Canonical choices you’ll also see
Linux XP Lite, Wifiway, xPUD,
Mythbuntu, Linux Mint (4 varieties), XBMC, YlmF, and Zenwalk.
BackTrack (3 choices), or Debian (4
editions).
Forgive me if I missed a couple
or misspelled others, but it’s
Installer goes beyond Ubuntu,
apparent nearly every Linux and
though, and offers choices range
desktop variation has a
from operating systems to
representative in this group
recovery discs, penetration testers, somewhere.
and anti-virus programs (some for
Windows, too).
Can’t find your favorite? An
option at the bottom allows for
In the drop down list, you’ll also those not listed, and I understand
find Acronis Rescue, ArchBang,
some techies have managed to use
ArchLinux, ArtistX, AVG Antivirus,
Installer to create bootable
Avira, BitDefender, Blackbuntu,
Windows XP versions, although I’m
CentOS, Clonezilla Maverick,
sure Microsoft’s attorneys are
CrunchBang, Dbau, DSL, DrWeb,
really interested in that
Dynebolic, EasyPeasy, EEEbuntu,
development.
18
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Since this is an Ubuntu-based
publication, I’ll stick with those
variations.

new version of Installer was issued
in early April, 2011, so much of the
information online from before
that month is now outdated.

Lesson number one – don’t
even think of using that 1GB flash
drive you’ve had hanging around in
the desk. If base Ubuntu is pushing
800MB, that leaves no more than
200MB for storage - and that’s not
much. And if you plan on using one
of the big boys like ArtistX or
Ultimate Edition, you can plan on
using a much larger flash drive
since they start at 3GB.

For example, some of these
sources state CD/DVD or flashcardbased .iso images can be used by
Installer as the source code;
however, I could never get these to
work. Don’t know if it’s a program
tick, or something changed with
the newest version, but Installer
would not recognize anything for
me unless it was downloaded by
the program.

Consider 2GB the minimum for
base Ubuntu, but don’t go over
8GB. Installer limits persistence
space to 4GB, so even the largest
OS plus persistence won’t exceed
8GB.

That isn’t necessarily bad at all.
Installer reaches out to the OS of
choice website and drags the .iso
image back for you. Let’s be
realistic and admit not all websites
are created equal, and some
developers put more flash in their
sites than they do their OS. It may
take a little while but it beats
playing hide-and-go-seek with a
buried OS.

Size is not the only
consideration, though. Users that
computer hop are best served by
i386 32-bit versions. 64-bit
varieties limit you to that
processor, while a 32-bit OS will
work on just about any computer
out there.
Lesson number two – some
online tutorials are out-of-date. A

completed successfully.
You will see:

Now that you’ve seen what
Installer looks like, it’s time to go
close up and personal with what it
can do. There are 4 progressive
steps, i.e. each step cannot be
accessed until the previous one is

Step 1: Linux distribution
selection. Pick the version desired
from the massive listing I
mentioned earlier. Installer will
access the Internet if the “Locale
ISO Selected” box is not ticked.
Opting for an OS not listed means
you’ll have to point Installer to the
URL, but, in any case, expect a wait
as the OS is downloaded.
Step 2: Here Installer locates
the .iso image. By default, it points
to what it just downloaded. If not,
there is a browse button to help it
along.
Step 3: Flash drive (final
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destination) selection. It defaults
to the inserted flash drive. FAT32 is
used, and, if you don’t know how
your drive is set, count on using
“Check this box if you want to
format the Drive”.
Make sure Installer picks your
intended drive letter! Having the
wrong selection can and will delete
everything on that drive!
Step 4: Persistence allocation.
This doesn’t appear until step 3 is
completed. The newest Installer
version from April 2011 picks the
remaining flash drive space, up to
4GB.
Earlier versions require users to
pick persistence space, and this
caused confusion since persistence
contents ^
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is independent of OS size. Users
had to know OS size along with
drive size to determine
persistence, and choosing the
wrong figure could create a fatal
error.
The only problem with this
system is that it lacks feedback.
You have to assume how much of
the flash drive is reserved for
persistence, and there is no way of
telling until after the first boot. I
used an 8GB flash drive that never
presented a problem since Installer
always took 4GB irrespective of OS
size.

all goes well, the Ubuntu menu
should appear with the first option
being “Run Ubuntu from this USB”.
Some reviewers have
complained that boot times are
sluggish but this isn’t totally true.
The first boot requires users to
input keyboard style, language,
time zone, etc, but once that
information is saved, future boot
times are within standard livemode parameters (base Ubuntu
10.10 came up within 1 minute).

and you don’t want to find out too
late that all your effort cannot be
saved because insufficient space
exists. If you lack that program,
right click the desktop icon or file,
and get remaining space
information.

example, wireless codes are not
the same, but I did discover that
Installer can save multiple codecs,
drivers, and even wifi passwords,
for various computers, and will
adjust itself as it recognizes them.

Ah, but there is another
Once the command to shut
question some have asked. Can
down is given, users are asked to
Installer create a multi-boot
save or ignore changes made, and
persistent flash drive?
the computer shuts down just like a
live mode CD/DVD would.
No, it’s a one-OS program, but
its cousin, Yumi (Your Universal
Now for the question that I’m
Multiboot Installer) will. It’s
Keep in mind you are operating sure a few are itching to ask. Is full offered on the same website, but I
from a flash drive, so lag time is
installation still an option, and will
can’t comment on it yet – that’s my
inevitable as programs are
changes made to the original drive next experiment (although my
Lesson number three – no
accessed, but flash drives are still
transfer?
initial peek shows it to be Installer
current Ubuntu based OS exceeds
quicker than comparable DVD
with the added capability of
4GB, far as I know. That means an
versions.
The “Install Ubuntu x.xx” icon is creating multiple partitions on one
8GB flash drive is safe for any OS in
on the desktop, and everything
flash drive).
this category since the fattest
Another thing to remember is
you’ve added, deleted. or
version plus 4GB persistence will
that changes will result in garbage otherwise changed in past
Using a 5-diamond rating
not exceed flash drive capacity.
file accumulation. Dead kernels and sessions, will still be there just as
system, I’d give Installer 4 - based
update files will still hang around,
you left it earlier. Full installation is upon its ease of use, extensive OS
Once everything is set, click
so plan on using Computer Janitor
the same as using a live-mode
listing, program design, and end
Create, and take a break. You won’t or Ubuntu Tweak to get rid of
CD/DVD.
results. I dropped it a point for
have to wait more than 5 to 15
those - or your drive will fill up
being a Windows only program,
minutes before seeing the
quicker than you realize.
No program is faultless, but
and for having a flash drive
successful completion notification.
computer hoppers will have to
recognition system that, although
This is where Disk Usage
realize that no two computers are
better than originally designed,
Testing is merely a matter of
Analyzer comes into play. Be sure
the same. Using the drive on
still doesn’t tell users how much
resetting the BIOS on a computer
to check it often since there is no
various units means parameters
storage space they have until after
to boot from the persistent drive. If feedback on remaining drive space, have to be changed for each. For
the initial boot.
full circle magazine #56
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Connect To IRC

Written by Chris Rheinherren

RC stands for Internet Relay
Chat. It's the oldest, largest,
and most well-established
text-based chat system on the
Internet. It’s also quite popular,
and used world-wide. Only web
browsing and email are used more
than IRC. At any given time, there
are nearly 800,000 users accessing
the various IRC networks.
In order to connect to IRC, you
need an IRC client. Just like you
need a web browser to surf the
web, it serves the same purpose: a
program that allows you to access
the service. There are a number of
different options available, there
are GUI based clients such as XChat, Konversation, and an IRC
plug-in for Pidgin. Also there are
terminal clients such as IRSSI and
others. X-Chat and Pidgin are
primarily used on GNOME and
Unity, while Konversation is part of
the KDE desktop environment. But
feel free to use whichever you feel
more comfortable with. I use the
terminal IRSSI myself, and, from
time to time, use the IRC function
built into Pidgin. There are also
web-based clients.

When you run your IRC client for
the first time, the first thing to do
is tell it what nickname you want to
use. How you do it will depend on
what client you choose.
In general, on IRC, you are
allowed to use any nick you'd like as long as no one else is using it at
the same time. However, on
Freenode (and many other
networks), it is possible to register
your nick so that you are the only
user allowed to use it. To do this,
type:
/msg nickserv register
<password> <email address>

For example: /msg nickserv
register foo foo@bar.net
Then, every time you log in with
that nick, the first thing you should
do is type:
/msg nickserv identify
<password>

For example: /msg nickserv
identify foo.
Registering your nickname is
useful for several reasons, here are
full circle magazine #56

a few. Sometimes, due to certain
conditions on the Internet, you get
disconnected from the server,
reconnect, and find that your nick
is still in use. In other words, you
got disconnected, but the server
hasn't found out yet and thinks
your old connection is still active. If
you haven't registered the nick,
you'll have to wait for the old
connection to die (which could take
a while), but if you've registered
your nick, you can take the
initiative and have it killed. To kill
off a "ghost" like that, use the
ghost-kill command:
/msg nickserv ghost <nick>
<password>

with the ghost's nick and your
password in the appropriate
places. This will cause NickServ to
force that connection to terminate,
allowing you to change your nick
back (with /nick) and go about your
business.

long it is kept reserved varies from
network to network, however.
If you forget to identify for your
nick, NickServ may change your
nick. However, there is usually a
time delay that prevents rapid nick
changes - just wait a few seconds
to change your nick again.
Remember that you will still have
to identify once you've changed
the nick, otherwise NickServ will
give you the boot again. To change
your nick, use the /nick command.
Now you can connect to IRC.
There are several different IRC
networks, each with their quirks.
The one I spend most of my time
on, and the one I have the most
experience with, is the
OtherWorlders network.
OtherWorlders is a small network
primarily aimed at the paper-andpencil gamer community, so if you
play D&D and other RPGs, then it
may be something you should
check out. Its connection address is
irc.otherworlders.org

Also the network where your
nick is registered will keep the
name reserved just for you or
Additionally, there are the BIG 4
anyone who has the password. How networks of Undernet
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(irc.undernet.org), Quakenet
(irc.quakenet.org), Dalnet
(irc.dal.net), and IRCNet
(irc.ircnet.org). There is also
Freenode (irc.freenode.org) which
is the home to many open source
projects and related chats. All of
the official Ubuntu chats are
located on Freenode, including the
chat for Full Circle Magazine.
On IRC, chatrooms are called
Channels, and generally begin with
the # sign, such as
#fullcirclemagazine. Since IRC is
based solely on text, all commands
are entered via the keyboard. The
first important command is join,
this allows you to join a channel, or
create a new one if it doesn’t
already exist. In order for the
server to know that you have
issued a command instead of
wanting to send text to the current
window, all commands are prefixed
with a forward slash: /
So to join our
#fullcirclemagazine chat on
Freenode after we connect, the
command is:
/join #fullcirclemagazine

Once in the channel, you can go
ahead and talk! Anything you type

in the channel is sent once you hit
Enter, unless it is prefixed with the
forward slash to indicate it is a
command being sent to the server.

be away from the computer for a
while, I'd type:
/nick Bynwafk

to change my nick to Bynw-afk
If you start your message with
the word /me, it will broadcast your (AFK stands for "Away From
message in the third person (this is Keyboard").
used for emotes and actions): for
If you want to join another
example, if I (nick = Bynw) type:
channel, use /join. Put the channel
/me does jumping jacks
name after /join, like this:
it will show up in the channel as:

/join #fullcirclemagazine

* Bynw does jumping jacks

If the channel doesn't exist yet,
it will be created and you will be its
operator.

...and sometimes in a different
color depending on the client.
(Note: be sure you write your
actions in the third person, instead
of falling back on the first person,
since it's supposed to be describing
something you're doing as if the
other people in the channel are
seeing it. It's a common mistake to
write something like "/me goes out
to get myself a drink", which would
show up in-channel in my case as "*
Bynw goes out to get myself a
drink", which sounds awkward)
To change your nickname, you
use the /nick command. The next
word after /nick becomes your new
nick: e.g., if I want to show that I'll
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If somebody is bothering you,
most clients have an /ignore
command. To prevent any
messages from a specific user from
showing up in your client, type
/ignore followed by the nick of the
offending party.
If you ever want to leave a
channel, you use /part. Put the
name of the channel after /part: to
leave #fullcirclemagazine, you'd
type:
/part #fullcirclemagazine

If you want, you add a message
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after the channel name, which will
show up as a "parting message".
This doesn’t make you leave IRC or
disconnect from the server or
network, however, only the specific
channel. You can be in multiple
channels at the same time.
If you want to log off, you use
/quit. You don't have to type
anything after /quit, but like /part
you can add a message if you like.
Finally, /help is implemented in
most clients as a way to access help
pages. It also allows you to specify
what you want help on by adding
parameters to /help. For example,
to get help on the /ignore
command, you'd type:
/help ignore

In the list of users on the
channel, some are prefixed with an
@, ~ or & and usually show up at
the top of the list. In other clients,
these may show as different types
of icons. These are the channel
operators, commonly called
chanops or just ops. The ops run
the channel - they can kick people
out, ban people from entering,
change the channel's modes (how
it behaves), and more. They're
there to keep the channel running
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smoothly. Those that have the ~ in
front of their names are higher
ranking channel ops, usually the
channel owners, while those with
the @ sign are channel hosts.
On some channels, you'll see
some users with a + sign in front of
their nicks. This is called "voice",
and it's really only meaningful on
moderated channels (channels with
the mode "m" set), where it means
that they are allowed to speak. On
unmoderated channels, it's usually
just there for show, or to designate
some special status about the user.
Both users and channels have
different modes available. These
are designated by different flags
given to a channel or nick. Most IRC
networks now automatically set all
users on connect to +i which is the
“invisible” mode. This prevents you
from showing up in lists of all users
on the network. So, to talk to you,
somebody either has to join a
channel you happen to be on or
already know your nick. If you have
this mode set, you are much less
likely to get random messages
from people you don't know asking
you if you want to chat. You can
turn it on by typing "/mode +i" and
off with "/mode -i". It's nice to
have.

Other user modes exist, but
some are reserved for admins and
IRC operators (called IRCops, or
opers, these folks help run the
network, but unlike the admins
they don't have physical access to
the servers). You won't be able to
set these on yourself, and they're
really not that interesting to
anyone who isn't running the show
anyway.
When you're in a channel, your
client shows a bunch of characters
like "+nrtu" in the title bar along
with the name of the channel and
the topic. These are channel
modes, which give the channel
special characteristics. They can
only be set by the ops
+i - invite-only. To enter this
channel, an op has to have invited
you in with the /invite command.
+k - key. To enter this channel,
you need to add a special password
after the channel name when using
the /join command.
+l - limit. No more than a certain
number of users are allowed into
the channel at a time. The number
itself appears after the list of
modes.
+m - moderated channel. Only
ops and voices can speak, everyone
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else is muted.
+n - no outsider messages. Only
users in the channel can speak on
it. Almost all channels have this
mode set. Setting this mode is one
of the first things most people do
when they form a channel.
+p - private. The channel does
show up in a list of channels (the
/list command) but the topic
cannot be viewed from the list.
+r - registered. The channel has
been registered with ChanServ.
(This can be set only by ChanServ,
not normal users)
+s - secret. The channel doesn’t
show up in a list of channels (the
/list command) or in the /WHOIS
<nick> info, which lists the
channels a given user is in.
+t - Topics set by ops. When this
is set, only ops can set the
channeltopic. If it's not set, then
any user in the channel can set the
topic with the /topic command.
Like +n, almost all channels have
this.
As well as these general modes,
there are a few that affect specific
users. These don't show up in the
list of modes:
+o gives a user op status,
+ v gives a user voice,
+b bans a user (prevents them
from entering the channel or, if
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they are in the channel, prevents
them from speaking).
ChanServ, along with its partner
NickServ (and others - depending
on the network) is a program that
runs on the network with special
privileges. Its job is to maintain
channels that have been registered
with it. It automatically gives ops to
the channel founder and to other
users designated by the founder.
To get more info on the
services, type:
/msg nickserv help
/msg chanserv help
/msg <otherservname> help

As well as chatting on channels,
it's possible to chat privately with
individual users. Most GUI based
clients do allow you to double-click
on a user's nick in the list of names
on a channel to open a new
window for chatting with that
person. You can also type:
/msg <nick> <message>

on any client. On most clients,
each private chat usually gets its
own window.
Sometimes a bunch of users will
contents ^

HOWTO - CONNECT TO IRC
seem to all quit at once with the
same quit message. What
happened is that their server has
lost contact with your server. This
is called a "netsplit", since it splits
the IRC network into two pieces.
The strange quit message is
actually the addresses of the two
servers that lost contact.
If someone suddenly looses
their connection to the server, then
they may quit with the message of
“connection reset by peer” … or
system generated quit messages
such as “ping timeout”, this
happens, again, if your connection
dies and the server issues a ping to
your connection to see if it is still
active and doesn’t get a reply back.

Installing the various
chat clients for IRC.
All of them are available in
Ubuntu's repositories. Just use the
Ubuntu Software Center, terminal
apt-get, or other package
management software of your
choice, in order to install X-Chat,
Konversation, IRSSI, or Pidgin and
its IRC addons.
With Pidgin, it also best to
install the IRC extras plugins - IRC

helper and IRC more at the very
least. For Pidgin, go to Accounts >
Add and choose IRC. On the Basic
tab, choose your username, that is
your Nick on IRC. For server, put in
irc.freenode.org (to get to
Freenode, or whatever network
you want to connect to is fine).
There are other options on the
Advanced tab, but we can look at
those another time. And go ahead
and click Add. You will
automatically be connected to
Freenode, but will be outside of a
channel at this point. If you get any
kind of a message about NickServ
asking for your password and you
haven't registered yet, then you
will need to choose another nick
with the /nick command.
You can use the Join a Chat
option under Buddies in Pidgin to
join the #fullcirclemagazine
channel. From here you can chat
away with all of us.

A few other features of IRC are:
CTCP (client to client protocol)
isn’t used much. But it’s good to
test for lag on a connection using
/ctcp ping nick or #channel and
there are a few other commands
that may be available depending
on the client you use. Check out
your client’s help file for those.
It's possible to trade files over
IRC using a feature called DCC
(which stands for Direct Client
Connection). Most GUI based
clients have menus and other
options to make this task easier.
DCC is fairly convenient and
trustworthy for moderately-sized
files like text, graphics, or short
sounds. For longer files like movies,
you'll want to use another means
of transmission. Remember this is
IRC … Internet Relay Chat - not file
transfer.

You can also use DCC to chat.
The main difference between
regular private chat and DCC chat
is that DCC chat, once started, is
independent of the IRC network
itself - even if the entire IRC
network crashes, or one or both of
the people chatting disconnect
from the server, the chat will be
unaffected.
DCC works by trading IP
addresses, then creating a direct
connection between the two
computers that bypasses IRC
completely.
I hope to start monthly IRC chats
sometime in early 2012. I’ll send
a message to those of you who’ve
subscribed via the FCM site, and
via Facebook and Google+. Feel
free to experiment with your IRC
client using the FCM chat room. I
hope to see you there! - Ed

For IRSSI, it’s a bit more
complicated, since there is no GUI
and everything is done via the
terminal. But still, you start the
application, connect to a server of
your choice, then join a channel so
you can chat away. There are more
complexities and you should read
its documentation for them.
full circle magazine #56
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Write For Full Circle Magazine

Written by Ronnie Tucker

Guidelines

T

he single rule for an
article is that it must
somehow be linked to
Ubuntu or one of the
many derivatives of Ubuntu
(Kubuntu, Xubuntu, Lubuntu, etc).
Write your article in whichever
software you choose. I would
recommend OpenOffice, but
PLEASE SPELL AND GRAMMAR
CHECK IT!

Writing
In your article, please indicate
where you would like a particular
image to be placed. Please do not
embed images into your Open
Office document.

Images
Images should be JPG with low
compression.
Regarding image sizes: if in
doubt, send a full size screengrab
and we will crop the image.

If you are writing a review,
please follow the guidelines shown
here.
For a more detailed list of the
style rules and common pitfalls
please refer to:
https://wiki.ubuntu.com/UbuntuMa
gazine/Style - in short: US spelling,
no l33t speak and no smilies.
When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org
If you can't write articles, but
hang out in Ubuntu Forums, send
us interesting forum threads that
we could print.

Non-English Writers
If your native language is not
English, don't worry. Write your
article, and one of the
proofreaders will read it for you
and correct any grammatical or
spelling errors. Not only are you
helping the magazine and the
community, but we'll help you with
your English!
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REVIEWS
Games/Applications
When reviewing games/applications please state clearly:
•
•
•
•
•
•
•

title of the game
who makes the game
is it free, or a paid download?
where to get it from (give download/homepage URL)
is it Linux native, or did you use Wine?
your marks out of five
a summary with positive and negative points

Hardware
When reviewing hardware please state clearly:
•
•
•
•
•
•
•

make and model of the hardware
what category would you put this hardware into?
any glitches that you may have had while using the hardware?
easy to get the hardware working in Linux?
did you have to use Windows drivers?
marks out of five
a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.
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XBMC (Xbox Media Centre)

Written by Charles McColm

very year, around this
time, my wife and I are
normally invited to a few
parties. This year we
decided we wanted to stay home and host a few parties. We wanted
an all-in-one entertainment
solution that we could quickly
switch between music, movies for
the children (or children in us), and
pictures. A number of prepackaged multimedia solutions
exist out there, but we wanted the
flexibility of open-source. We
decided to create our own XBMC XBMC Media Center (formerly
known as XBox Media Center)

system.
XBMC will run on most
hardware that runs Ubuntu 10.04
or later. If you want to decode high
definition video, a dual-core
processor is strongly
recommended. Since we're
decoding video, a good video card
is also recommended. Those things
said, my wife and I opted for the
portability and elegance of a Dell
Inspiron Mini 1012 netbook over a
high-powered but clunky looking
PC sitting beside our television. I'd
mentioned the project to a friend
whose company just bought a
bunch of HP computers that came

complete with HP media center
infrared remote controls and USB
infrared receivers. In the past,
we've connected a wireless
keyboard to our media systems,
but a remote control is much
friendlier and takes up a lot less
space.

sudo aptget install xbmc
xbmcstandalone
sudo aptget update

The second command adds the
PPA (repository) for XBMC on most
versions of Ubuntu. Unfortunately,
We ran XBMC for some time on it seems the team has yet to make
an Oneiric branch, so, if you're
Ubuntu 11.04, but arrived at a
using Ubuntu 11.10, try adding the
point where it was crashing daily.
This may have been due to the Intel following repository:
video chip inside our Mini, which
sudo aptaddrepository
has been causing grief for a lot of
ppa:nathan
people lately. One solution is to
renniewaldock/xbmcstable
use VESA drivers, but it's not really
a solution for a media center, so we
Again, we find XBMC on 11.10
backed up and installed Ubuntu
unstable, but that doesn't mean
10.04 LTS and haven't had a
you'll have the same experience if
problem since.
you're using an NVidia or ATI video
card. Nvidia card owners should
Installing XBMC is relatively
add VDPAU hardware acceleration:
easy on Ubuntu 10.04 or later. In a
sudo aptget install
terminal, type the following 5
libvdpau1 nvidia185libvdpau
commands:
sudo aptget install python
softwareproperties pkg
config
sudo addaptrepository
ppa:teamxbmc
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The last step is adding support
for remote controls. While XBMC
worked out of box with our HP
remote control, I found some of
the buttons were not working
contents ^
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correctly, so I installed lirc support:

this by changing the weather
source in the System > Weather
menu to Weather Plus (which we
found by clicking the Get More
button at the bottom of the source
screen). Not exactly party material,
but useful to know for those
having problems getting weather
working.

sudo aptget install lirc

On the remote selection screen,
I chose the Windows Media Center
Transceivers/Remotes (all). This
selection was all we needed to do
to get most of the other buttons
on the remote working perfectly.
Now, it's time to run XBMC for
the first time, and add your media.
The XBMC main menu is divided
into 6 menu options: weather,
pictures, music, videos, programs,
and system. Adding media to XBMC
is just a matter of adding the media
to the right area. For each of
pictures, music, and videos,
navigate to the appropriate menu
option and press ok/select on your
remote. Without any media added
you'll see a couple of options - Addons and Add source. Select Add
source, then browse to the area
where your media is stored, give it
a name, and click OK to accept the
choice. You can have multiple
sources for the same media. To
differentiate sources, simply give
the source a different name. For
example, you might have pictures
from last Christmas and an office
party (a good mix with the right
music).

Once you have all your media
imported, the party can really
begin. XBMC, like a lot of other
great open-source software,
supports a myriad of options, skins,
and plug-ins. One of the options I
like most is the ability to view
content in a variety of ways.
Pressing the left arrow button on
the remote control brings up a side
panel that lets you choose the view
and sort method. The misc options
lets you hide watched content,
filter content, and hide fanart among other things. But these
views don't look so great without
cover art. To add cover art to new
content, select the content and hit
the info button on the remote.
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XBMC can also automatically fetch
cover art by System > Video >
Library > Update library on startup.
XBMC can also autofetch cover art
for music much the same way by
selecting System > Music > Library
and Update library on startup.
One of the more confounding
problems we ran into was getting
the weather correct. We set our
location to Waterloo, Ontario
(Canada), but kept getting
Fahrenheit. To make the switch to
Celsius, we needed to set the
Region under System > Appearance
> International to Canada. We also
ran into a problem where the
weather.com default seemed to
stop working. We managed to fix
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What is cool for a party is the
ability to play music and run a slide
show of photos from all those
crazy office parties – and it's easy
to do. First, cue up music by
selecting the music folder you
want to play. Incidentally, if you
press the right arrow on the
remote while in the music folder,
you can set music to repeat or play
randomly. Next, press the Pictures
button on the remote control,
navigate to the pictures source you
want, and hit Play. A photo slide
show starts with a small rectangle
in the bottom left corner
displaying information about the
song currently playing.
The same technique works if
you want to check the weather or
check out your video collection.
XBMC is smart enough not to play
music and movies at the same
time. It's either music or movies,
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you can't play both the same way
you can play music and pictures at
the same time.
XBMC is great at recognizing
movies, but XBMC also recognizes
television programs. When naming
television series include the season
and episode. For example: The IT
Crowd s02e03 (The IT Crowd
Season 2, Episode 3, way better
than The Office if you ask me). If
XBMC doesn't recognize a movie or
television show, try variations on
the name. If you're really stuck, try
to find the program on
thetvdb.com or themoviedb.org
(sources XBMC draws on).
We've covered only a tiny set of
XBMC's capabilities. Video add-ons
let you stream television and
movies from different sources like
Youtube, Yahoo video, the Cartoon
Network, CNet, Jupiter
Broadcasting, and the Internet
Archive - to name a few. Music add-

ons include streaming from
sources like Grooveshark, TWiT,
NPR, ListenLiveEU (which has over
600 stations listed), and
SoundCloud. Also be sure to check
out the add-ons under the
Programs main menu to check your
Gmail account, post your video
watching habits to Gomiso, or
download extra fan generated
artwork from thetvdb.com and
themoviedb.org. Combine XBMC
with the Transmission bittorrent
client and Flexget, and you can
script the download of a lot of
content.

Important Links:
http://www.xbmc.org/
http://wiki.xbmc.org/index.php?titl
e=HOWTO:Install_XBMC_on_Ubuntu/
http://www.themoviedb.org/
http://www.thetvdb.com/

Charles......

The only thing left is to put out
the food, crank up the volume, and
party.
full circle magazine #56
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CLOSING WINDOWS Control Panel / Device Manager
somewhere, you navigate to the
location using the “Move Items” or
“Copy Items” window, and click the
‘Move’ or ‘Copy’ button, respectively.
Kubuntu does this in a similar way.

Written by:
Ronnie Tucker (KDE)
Jan Mussche (Gnome)
Elizabeth Krumbach (XFCE)
Mark Boyajian (LXDE)
David Tigue (Unity)

T

his month, we’ll discuss
the moving, copying, and
renaming of files. We’ll
also take a quick look at
how to delete a file, and (should a
mistake occur) undeleting (or
restoring) a deleted file.

Kubuntu

Ubuntu (Classic)

Kubuntu

Moving / Copying A File
First, a quick distinction: moving
a file will physically shift that
file/folder to another place.
Copying will place a copy of the
file/folder in another place, but
keep the original where it is.

Lubuntu

Ubuntu (Unity)

Xubuntu

Windows XP

Windows
You can move/copy a file in
several different ways. The first is
by selecting (left-clicking) on the
file/folder and choosing ‘Move To...’
or ‘Copy To...’ from the Edit menu in
the main menu bar. To put the file
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Right-clicking a file(s) or folder(s)
reveals a pop-up menu with all filehandling options.
You can also move/copy a file by
dragging and dropping it from
window to window. Windows XP
requires you to hold down the
Control-key while you release the
left button to move a file/folder.
Simply dragging a file/folder to
another location will copy the file.
Kubuntu does this too, but it also
has a unique feature in that, when
you drop the file with no keys
pressed, a menu will pop up asking
you if you want to move/copy the
file.
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Gnome-Shell
In Gnome, things are more or
less the same as in Windows and
Kubuntu. The Nautilus file manager
uses a menu, available with the
right mouse-click, with items like
cut and copy. It’s also possible to
just drag and drop files/folders to
their new locations. Whether the
file/folder is moved or copied
depends on the use of the Shift or
Control-key, or on the source and
destination locations:
• If the source and destination is on
the same disk-partition, then
dragging and dropping a file/folder
will move it, the original file/folder
is no longer in its original location.
• If they are on two different
partitions, or disks, then a copy will
be made. This is visible by means of
a little plus sign on the hand that
drags the file/folder.
Unity
Ubuntu has based Unity on
Gnome Shell—Gnome 3.x is the
base system—so things are done in
much the same manner. Unity, like
Gnome Shell, uses Nautilus as the
file manager, so, to move a file, you
can right-click on the file and select
‘Cut’. Now navigate to the location
you want to place the file, and

right-click in the white-space of the
folder and select ‘Paste’. To copy a
file, use the same method as
before, but, instead, click ‘Copy’ on
the original file. You can also use
the drag/drop method. As in
Gnome Shell, you should remember
that if the file/folder is located on
the same partition, the file will be
moved by default, and, if it is on
different partitions, it will be
copied.
Lubuntu
Lubuntu is similar, but with
some minor differences. When you
select a file(s) or folder(s) and then
right-click, a context menu is
revealed with the “usual” file
handling options, though there is
no “Move” option in this menu.

File Manager window, it will move
the file, and holding down “Shift”
when you click and drag the file will
do the same. If you wish to copy
the file, you can right click on the
filename and select “Copy”, and in
the new directory you’ll right click,
and select “Paste” to paste the
copied file.

Renaming A File
In all variants, this is done by
right-clicking the file you want to
rename, and choosing ‘Rename’.

Gnome, KDE, and LXDE all have
a nice renaming feature, which is,
that after right-clicking the file and
choosing ‘Rename’, only the filename is selected, you’ll see that
the file-extension (if present) is not
selected. So, when you want to
To “Move” a file/folder using
rename a picture from your camera
this menu, you first have to “Cut”
(IMG_0001.JPG) into House-on-thethe file, then navigate to the
beach.JPG, you can just start
destination and “Paste” it; however, typing without worrying about
the File Manager Edit menu does
accidentally changing the fileprovide “Move To...” and “Copy
extension as it will not be deleted
To...” options which function as
or renamed: a JPG will still be a
described above for MS Windows.
JPG. This is different from
Windows where you have to be
Xubuntu
careful not to erase the file
extension.
In Xubuntu, when you click on a
file and drag it to another Thunar
full circle magazine #56
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Deleting A File
A file that is deleted is not gone
forever—it’s sitting in a special
place where the file can be
restored. The only time a deleted
file can not be restored is when the
Waste-bin (or equivalent) is
emptied. After the Waste-bin is
emptied the file is gone forever.
Windows
Deleting a file is, like renaming,
done using the right-click menu
mentioned earlier. Or, you can drag
a file/folder to the ‘Trash Can’ icon
that’s on your XP desktop.
Kubuntu
Kubuntu has no desktop icon
for its ‘Waste-bin.’ However, there
is a Trash Can directory that is
displayed by default in the File
Manager, and any file(s)/folder(s)
can be dragged to it for “disposal”.
Likewise, any files/folders that are
deleted (either from the menu or
by pressing the Delete key on the
keyboard) are placed in the Trash
Can by default, but you can still
right-click a file to choose Delete,
or use the ‘Add Widget’ item (by
right-clicking on the
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desktop/taskbar) to add a Wastebin icon.
Gnome-Shell
Gnome-Shell has a Waste-bin,
called Trash, on the right side of the
lower panel. All the normal ways of
deleting a file work here: Del on
keyboard, right-click and select
Move to Trash, dragging the file to
Ubuntu (Classic) the Trash-bin.

Kubuntu

Another option (similar to the
Unity notes below re adding Delete
to the right-click menu) is the key
combination Shift-Delete. This
bypasses the Trash, and, once
confirmed, the file will be gone for
ever. So be very careful using this.
Unity
Lubuntu

Ubuntu (Unity)

Xubuntu

Windows XP
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In Unity, there is a Trash icon in
the bottom left-hand corner of the
dock. You can delete files in a
couple of different ways. In the file
manager, there is a Trash folder on
the left-hand side. You can click a
file and drag it in to the Trash
folder, or drag it to the ‘Trash’ icon
on the dock. Also, you can rightclick on it and select ‘Move to
Trash’. You may also want to look in
the preferences in the file manager
(Nautilus), you can select Edit >
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Preferences, and, under the the
‘Behavior’ tab at the very bottom is
a check-mark to add a ‘Delete’
option to the right click menu that
will remove the file completely bypassing the Trash. You will not be
able to recover this file by restoring
it from the Trash, so be very careful
if using this option.
Lubuntu
Lubuntu also has no “Trash Can”
icon on the desktop; but has a Trash
folder that is always visible in the
File Manager. Right-clicking the
Trash folder opens one menu
option: “Empty Trash”. You can also
select specific files/folders in the
Trash and permanently delete
them—by showing the pop-up
menu (right-click) and selecting
Delete.
Xubuntu
Xubuntu also has a Waste-bin
called Trash; it is located on the
Desktop and also in the right-hand
side of the bottom panel by
default.

Restoring A File
Kubuntu
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If the waste-bin has not been
emptied, you can click its
icon/name and view the contents

Numbers 1 to 9 are to be filled into the 9x9
grid so that every row, every column, and every
3x3 box contains the numbers 1 through 9.

Next month we’ll look at network
and wifi controls.

EASY

Gnome-Shell
In Gnome you can do the same
as in KDE, or, after selecting the
file(s)/folder(s) you want to
restore, click the button “Restore
selected items” on top of the
frame.

Kubuntu

Ubuntu (Classic)

Unity
Unity works in the same way as
Gnome Shell and KDE. Open the
Trash, right-click on the file, and
click ‘Restore’, or you can click the
‘Restore Selected Items’ button.
Lubuntu

HARD

Lubuntu

Ubuntu (Unity)

You can either drag and drop
the file back to somewhere, or
right-click it and choose to
‘Restore’ it.
Xubuntu
In Xubuntu, you do the same as
in Kubuntu, a “Restore” option is in
the right-click menu.
Xubuntu
full circle magazine #56
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Solutions are on the second last page.
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A Penguin In The Office?

Written by Maurice Knopp

first got in touch with Ubuntu
out of curiosity (and lack of
Windows licenses) in 2005 with
the 5.04 Hoary Hedgehog
release. I installed it on my
mother’s old Pentium III – 600 MHz.
In the following weeks, Ubuntu
began to emerge as my primary
operating system, and I finally
installed it on my own machine.

Penguin in the Office –
Why would one do that?
In 2007, I worked for a large
media company located in
Luxembourg to develop a software
component which can process
video signals and feed it to the
video encoder ffmpeg. The final
system should be run on a Linux
server due to issues of stability,
reliability, and cost savings. So, for
development ease, I began to use
the Linux machine I was developing
on for day-to-day office tasks as
well. It was the time of Feisty Fawn
(7.04) and Gutsy Gibbon (7.10). So, I
was keen enough to install a Linux
desktop machine within a company
which had around 450 Windows XP

boxes, Windows infrastructure, and
Windows people all around, with
zero Linux office usage.
In summer 2010, I started
working for a large publishing
house in Germany - heavily focused
on Java development around a
content management system. To
my surprise, the whole dev team
already used Ubuntu when I
arrived. Why do you do that?
“Speed! We can't bear Vista....” Now,
I've been using Ubuntu since day
one for development and office
tasks, and I'm happy with it ever
since.

Setup of your box
Back in 2007, I chose the 32-bit
version (x86) for installation on the
desktop machine because, back
then, you encountered far less
problems, especially with browser
plugins such as Adobe flash. Today,
these kinds of issues are mostly
solved, and I would recommend
installing the 64-bit version
(x86_64) on any computer which is
not older than three years and has
a 64-bit processor.
full circle magazine #56

times. Compare this to browsing
the web, downloading several
Once installed, in a couple in
minutes, you can install most of the software (components) from
software you'll ever need from the several websites, and manually
“Ubuntu Software Center” (used to installing several setup.exe's,
be called “Synaptic”) which is based leading to several reboots.... Yeah, I
know you can script Windows
on the integrated package
installations as well, but, in my
management system. E-Mail
opinion, you'll have to put in far
Client(s), Browser(s), and Instant
more effort.
Messaging software is already
installed out of the box.
For the Pros: Just search all of
the software you want to install,
and save the package list to a text
file. You can now install any
amount of fresh machines and
issue the command “sudo apt-get
install <loooong list of packages,
space separated>”. This way, you
kind of “clone” your setup multiple
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Office work
Mail
So, let’s get to integration of
your fresh box into the Windows
network. Like most companies, the
ones I work(ed) for used the
famous MS Exchange Server - in
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MY STORY - A PENGUIN IN THE OFFICE?
connection with the Outlook Client
for mail exchange and scheduling
tasks. I've read that Evolution,
which is installed out of the box
(only on Ubuntu versions prior to
11.10, but it may be installed
manually in later versions), also can
handle Exchange servers. This is
exactly what I needed! So I
searched the web and found a
German tutorial
(http://www.msexchangefaq.de/cli
ents/evolution.htm) which explains
the necessary steps to configure
Evolution with Exchange Server.
The Novell documentation for
Evolution may also be a good
source for help on this topic
(http://www.novell.com/document
ation/nld/index.html?page=/docum
entation/nld/evolution/data/front.
html). I managed to successfully
get Evolution running on my
existing Exchange 2003 mail
account.
However, I've done some web
research, and I was not able to get
Exchange 2007 and above working
even with the most recent version
of Evolution. I now use the IMAP
support built into Exchange Server
to send and receive mails, which
works quite well. You might have to
ask your administrators to enable
IMAP on Exchange Server. I receive

a LOT of mail per day, and
otherwise I had to answer the
whole bunch over the Exchange
Web Interface known as “Outlook
Web Access”. Though being able to
connect to my mail account, I didn't
quite figure out how to access the
address book. That’s sad, but I have
the habit of just “replying” to
whoever wrote me. So, I can live
without the exchange address
book and build up my own local
one, but it would be nice if I could
figure out how to configure this
one day.
One drawback occurred in the
course of the last Ubuntu update.
Before 11.10, Oneiric Ocelot, I was
able to accept or decline meeting
requests from within Evolution,
which then would automatically
put the appointments into my
calendar. This feature seems to be
broken with 11.10, so I have to log
into the Outlook web interface to
reply and to do scheduling.
Shared Folders
Next thing, most companies
have a BIG shared network drive in
the office. Every file which is
related to a running project or is of
public interest, will just get
dumped on the network drive in
some folder. All Windows machines
full circle magazine #56

can access this drive, and read or
create their own files. So, as one
can imagine, it was very important
to me to get access to this drive
and continue working on the
shared files. I tried to determine
the IP of the file server machine
and access it from nautilus by
pressing CTRL+L and entering
smb://xxx.xxx.xxx.xxx where
xxx.xxx.xxx.xxx is the IP of the filemachine. In the popup mask, just
enter your Windows-login
credentials. You should see all
shared folders on the machine, and
just have to right-click on the
desired folder and choose “connect
to this server” from the contextmenu. DONE! The folder is added
to your favorite bar on the left,
and, from all nautilus instances,
you can now access the shared
folder as easy as your home or any
other folder! Hey, that’s even
cooler than navigating to “My
Computer” on the desktop and
then chose your shared network
drive or searching the “Network
Neighborhood”.
When pushing or pulling files
from Apple machines, I tend to use
the command line utilities. SSH to
connect to a remote machine
(apple or linux), or SCP to push or
pull files to or from a remote fruit
35

flavored box.
Also, most recent cloud storage
companies like “Dropbox”, with
clients for all major OSs, started
gaining ground and becoming
more and more popular. We're
using Dropbox with clients for
Windows, mac, and Linux, without
problems.

Office
Interoperability between MS
Office and OpenOffice / NeoOffice
(OO / NO) has been very important
to me because I regularly get these
kinds of documents. So, it is
necessary for the Windows guys
that I stick to their format (*.doc or
*.xls). I guess, for all people who
want to do some collaborative
work, the point of compatibility is
one of the most important ones. As
far as I can tell, there were no real
problems concerning reading and
writing files in the proprietary MS
document formats. I have to admit
that the most complex documents
that I tested contained a maximum
of thirty pages with a few images
and some tables. So, compatibility
may become worse if you have to
create more complex documents.
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MY STORY - A PENGUIN IN THE OFFICE
The functions of OO / NO cover
all the needs I had so far. Create
documents with a table of
contents, footmarks, (floating)
images, ..... I did not miss any
function in OO / NO that I knew
from MS Office. The only thing that
is lightyears ahead in MS Office is
the spell checker, which is really
helpful.

compatible. Anyway, you might not
see all available options and
capabilities of your printer within
the printing dialogue because of
driver limitations. For me, this was
not a real problem but I'd like also
to point out that I don't print out
very much.

Printer

There might be some other
tasks you have to do today with
your Windows box like updating
software. This is just a breeze with
Ubuntu's update mechanism, and a
great time saver.

This has been no real issue at
all. Once I had correctly
determined the IP and the model
of my office network printer, I had
no real problems in printing large
documents. Professional office
printers mostly support Postscript
drivers and should therefore be

Miscellaneous

Instant messaging, like I said
before, comes out of the box with
ad-free versions capable of using

all of the major IM-networks. You
can even install Skype with one
click in the Ubuntu software center.
I tend to use Jabber.

of knowledge and getting to know
another software world. Running
an entire office box based on Linux
is possible.

Back in 2007, I had to install the
graphics driver by myself on my
workstation computers. In the
latest version of Ubuntu you only
have to choose the proprietary
graphics driver for ATI or NVIDIA,
do a reboot, and everything should
be working fine.

I would be very interested in
your thoughts, just drop me email
at mak@maknesium.de You might
also want to visit my site
www.maknesium.de (partly English
/ German).

I listen to music, burn DVDs /
CDs, and use a dual monitor
configuration with no driver
problems. This was different when
I started using Ubuntu back in
2005.

Conclusion
Ubuntu is mature enough to be
used in most office environments!
Unless you use Microsoft Outlook
extensively with all advanced
features, or you have to use “just
this” program which doesn't have a
Linux version, you can try to set up
a Linux office box. I recommend
using an old machine side by side
(if your company allows), and to do
more and more tasks on the Linux
machine. You will benefit in terms
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Written by David Bissett

have used Linux as my main
operating system for over a
year now. I have tried various
flavours over the years OpenSuse and Mandriva, for
example - before settling on
Ubuntu. The reason for this choice
was mainly based on the relative
stability (in my limited experience
at the time of making the choice),
available support via many online
forums, and ease of use for the
average user. Unfortunately, I still
have a need for some Windows
applications, so, though I do use
one or two in Wine, I also have
Windows XP in a virtual machine on
my main desktop. Most
applications used on a daily basis
are, however, native Linux. The
main desktop machine, a self-build,
runs Ubuntu; a second, lower spec,
machine operates with Xubuntu;
while the laptop used by my wife
has the Ubuntu variant, Linux Mint.

most people than Windows. This
does not, however, mean there are
no problems.
Some of these problems centre
around the thing that is often held
up as a virtue - choice. Perhaps one
of the biggest choices is the
flavour of Linux to use - Debianbased with deb installable
packages, or Red Hat with rpm
packages. That isn't the end,
though, as it is then necessary to
choose the desktop to use. This is
more than simply choosing the
look - as many applications have
been developed specifically for one
desktop or the other. Usually, they
will work in any Linux environment.

This leads on to the chosen
applications. I've been trying
Chrome, Chromium, and Opera.
LibreOffice has taken the place of
OpenOffice, and I have just started
using Tweetdeck in Google
Chrome. For photos, there is only
Linux installs easily, and it can
one choice - Digikam. I have tried
be argued that if the main use is
Shotwell, which is OK, but I won't
going to be Internet, email, music,
with a bit of office-like work, then a use it until it is possible to order
the photos the way Digikam does.
machine loaded with a flavour of
Digikam works OK under Gnome
Linux would be a better choice for
full circle magazine #56

and Unity, but undoubtedly works
better under KDE, and is the main
reason I have considered KDE as a
desktop.
Banshee is the app used for
music and podcasts, a Gnome
application. This does everything
needed. Neither Amarok nor
Rhythmbox cover everything
needed in the way Banshee does,
so there is no real choice.
There are some other, more
subtle differences between KDE
and Gnome (when considering
these differences, many comments
made about Gnome also apply to
Unity. It should also be noted that
this is referring to Gnome 3.x).
Gnome remembers the state of the
num lock key, which is really useful
as I frequently use the number key
pad section of the keyboard. In my
experience, KDE doesn't do this.
Using a USB headset is also
extremely easy under Gnome as
you can easily switch between the
speakers and headset with a couple
of clicks of the mouse (this isn't
even very easy in Windows, at least
XP). While this may be possible in
37

KDE, it isn't very easy or intuitive.
Simply plugging the headset in
doesn't work in my experience, the
use of a USB headset is rather hit
or miss, but excellent in Gnome
and Unity.
It has to be admitted that KDE
looks great, and would be
preferred if only Gnome
applications would respond as well
in this environment as they do
under Gnome, and the couple of
significant niggles above were
addressed. As it is, the only viable
option for me is to go for Gnome
or Unity, and switch to KDE when I
think it might be preferable.
Linux is a great platform, and
the various versions of Ubuntu are
great implementations, but, if
greater take-up is to be
encouraged, there should be more
consideration of the non-expert
user - remember, users aren’t
necessarily interested in tinkering
under the bonnet. It would also
benefit the cause if there was
greater collaboration between the
major desktops to ensure better
cross-compatibility.
contents ^

Last month's question was:

I THINK...

Would you join us (FCM) on IRC for
a meeting once a month?
Which day suits you best?
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday
Sunday

Would you join us (FCM) on IRC
for a meeting once a month?
Maybe...
Yes, definitely!
Nah, not my kinda thing
Yes, but I'm not sure...

32%
36%
15%
17%

34%
30%
35%
34%
32%
52%
56%

And which times (in GMT)
suit you best?
6 - 7pm (GMT)
7 - 8pm (GMT)
9 - 10pm (GMT)
10 - 11pm (GMT)
11pm - 12 (GMT)

32%
35%
40%
26%
31%

And which week of the month
suits you?
first week
second week
third week
fourth week

79%
67%
64%
60%
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I THINK...

“

What is IRC ? And how can I
join it ? [see this month’s
HowTo - Ed]

“

Well, why not? FCM might find
my writing skills impressive
and useful.

“
“

Would love to interact with the
FCM Commune...

Will we be able to discuss
Linux questions, or only
questions related to the
magazine? [anything! - Ed]

“
“

I hope it isn't just for experts. [I
hope not, I’m no expert! - Ed]
I like the idea... we all run diff
distro's, so better feedback on

those from users.

“
“

Not sure what the purpose
would be, but it sounds cool.

A PLEA ON BEHALF OF THE
PODCAST PARTY

Don't know that I could
contribute but I'd sure listen
in, so to speak!

As you often hear in the podcast, we're calling
for opinion topics for that section of the show.

“

Let me know what time is
decided upon. [read on - Ed]

Instead of us having a rant about whatever
strikes us, why not prompt us with a topic and
watch for the mushroom clouds over the
horizon! It's highly unlikely that the three of us
will agree.

What does an IRC chat allow
that can't be found in, say,
sending suggestions by email?
[real-time feedback - Ed]

“

Or, an even more radical thought, send us an
opinion by way of a contribution!

“

Could the sessions be archived,
especially for those in Western
USA & Canada? [I’ll get the chat
logs posted to our wiki page - Ed]

You can post comments and opinions on the
podcast page at fullcirclemagazine.org, in our
Ubuntu Forums section, or email
podcast@fullcirclemagazine.org. You can also
send us a comment by recording an audio clip of
no more than 30 seconds and sending it to the
same address. Comments and audio may be
edited for length. Please remember this is a
family-friendly show.

This month we have a short questionnaire sponsored by
SpiderOak. By entering you could win 100GB of space on
SpiderOak. The questions are at: http://goo.gl/ewc1O. If you do
not wish to enter the competition simply leave the email box blank.

It would be great to have contributors come on
the show and express an
opinion in person.

Alternatively, post a message on Twitter with the hashtag
#IwantSpiderOak, or you can reply to our SpiderOak post on our
Facebook page at: http://www.facebook.com/fullcirclemagazine.
We’ll choose one winner from Twitter, one from Facebook, and
three from the questionnaire.

Robin

Competition closes on Friday 20th January 2012, and the winners
will be announced in FCM#57. Good luck!
full circle magazine #56
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REVIEW

Puppy Linux

Written by Robin Catling

P

uppy Linux was designed
as one of those small,
light-weight, Linux
distributions, intended
primarily for lower specification
hardware - whilst still providing a
full suite of applications and
utilities for a usable desktop
environment. Frugal with
resources, it was blindingly quick.

Woof, it can take binaries of other
popular distributions and
incorporate them into new Puppy
releases, among them many
components from Ubuntu such as
shared libraries and some
applications. This may have
something to do with Puppy rising
to number 9 in the Linux chart on
Distrowatch. Compatibility with
Ubuntu packages notwithstanding,

the spirit of the Puppy remains
independent.

supported in Puppy, as the bug
lists show.

Puppy is bootable from just
about any media, including
LiveCDs, zip disks, USB drives, and
hard drives. It does a reasonable
job of automatically detecting
most hardware. However, be wary
of installing on Ext4 formatted
partitions. Ext4 is not fully

Puppy's small size makes it a
good candidate to install onto USB
memory sticks, with the ability to
save any personalized settings and
installed software. At boot-time,
Puppy loads into RAM, which frees
up the boot device for other uses,
and makes for a very fast system.
On most systems, in fact, boot time
is just 30 to 40 seconds, even on my
old Pentium-II clone.

Lucid Puppy 5.2.5 is not the
latest release, dating from April 2,
2011 (the latest, 5.2.8, may be a
little too bleeding edge for really
old kit). The download is a 126MB
.ISO image file - which I decided
was worth a road-test on an
otherwise obsolete AMD chip-andmain-board combination from
1999.

The pragmatic mish-mash of
Puppy's interface and tools helps
provide the high performance.
Puppy uses JWM and OpenBox
with FBPanel, all known for their
minimal resource requirements.
Many of the tools are consolebased or have very simple 1990's
style low-res control decks. They
are easy to use, but it does feel like
a step back in time.

Puppy Linux 5.2.5 is based
primarily on Ubuntu 10.04 LTS
“Lucid Lynx,” but there's a mixture
of utilities provided using the
'Woof' build system, such as a later
version of the e2fsprogs filesystem utilities from Ubuntu 11.04
“Natty Narwhal.” Puppy 5.2.5 uses
version 2.6.33.2 of the Linux kernel,
and, thanks to that build system,

Otherwise, Puppy ships with
lots of smaller but useful
applications for a light-weight but
functional desktop. There's the
Gnumeric spreadsheet, Osmo
full circle magazine #56
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personal organizer, HomeBank
money management, Abiword, and
a selection of applications for
photo and image management,
text editors, and media player.
Slypheed is the default mail client
and Dillo the browser. See what I
mean? Step back in time.
Using the JWM Windows
Manager, the desktop is a riot of
colorful, Fisher-Price style icons.
The standard start-up sound is a
friendly bark. More themes are
available, and more programs are

available through the Puppy
Package Manager or using the
QuickPet alternative package
manager.
If you don't find what you want
in the Lucid Puppy repository, the
Ubuntu repositories can be used
with one tick-box. QuickPet
provides a one-click alternative to
install programs such as Firefox,
Pidgin, and LibreOffice, although
the performance of these was
tardy to say the least. I haven't
persuaded Open Office Writer to

run at all on my two test-beds.
The miracle of Puppy is that it
resurrected an old Pentium-II era
AMD-based machine with only
256Mb of memory. Desktop
performance was good, when the
equivalent Ubuntu live CD's for
11.04, 10.10 and 10.04 failed to
run, owing to modern kernel
constraints, much less install
locally. The screen-shot is of that
machine happily running Puppy,
and much faster than it ran
Windows XP.

Puppy remains a bit of a mixed
bag. I could run it on current
hardware - but I'm not sure I'd
want to suggest it as an alternative
to anyone but a bold tinkerer
familiar with Linux distributions; as
a fall-back on old kit, you can do
worse than take the Puppy for a
walk. Ouch. Sorry.
Puppy Linux official home page:
http://puppylinux.com/
Puppy Linux official wiki:
http://puppylinux.org/wikka/Home
Page

Where it surprisingly failed is in
Virtualbox, where the Puppy Live
CD managed to run badly, and
install to a virtual disk a version
which still won't boot despite much
remedial work.
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LETTERS

Every month we like to publish some of the emails we receive. If you would like to
submit a letter for publication, compliment or complaint, please email it to:
letters@fullcirclemagazine.org. PLEASE NOTE: some letters may be edited for space.

Correction

Mint Menu

n the HowTo article by Jesse
Aviles, “Ubuntu For Business &
Education – Pt. 3” (Full Circle
issue 54, page19), the RPN
expressions appear to me to be
incorrect, at least when I check
them on my HP 12c.

find that some of the strange
problems that I've complained
about are related to oddities
with the Mint menu app. I sure
hope that they fix them with Mint
12!

I

The operators used in the
expressions are binary operators,
using two inputs (not three) from
the stack. For the multiplication
operations, they must be done
twice to obtain the correct
answers:
15 5 div 7 + 20 3 x x = 600
15 5 div 20 3 x x 7 + = 187
I checked the Wiki reference,
which confirms this binary nature
of the operators.

I

Closing Windows

R

e: Ubuntu Control Center.

“In Ubuntu (Gnome), it’s called
Control Center, andin Natty it is
installed- but it does not show up in
the menus. ”

That may well be the source of
the problem that LeRoux (FCM#52)
mentioned with Office on
I can see it in 11.10; look on the
Wine/Mint 11. If that's the case, he top bar on the extreme right in the
should be able to manually build a
pull-down where you log off. It is
shortcut by navigating to the .exe
the first item.
file (it should run from there), and
working backwards. I know that the
Andrew Ampers Taylor
Wine shortcuts do work under
Xfce.
Oh, and the login app GDM(?) is
hardwired to right handed mice the source of one of my
complaints. I've requested a fix
from the developer's list.

Edward Owen
David O. Rowell

Join us on:
goo.gl/FRTMl
facebook.com/fullcircle
magazine
twitter.com/#!/fullcirclemag
linkedin.com/company/fullcircle-magazine
ubuntuforums.org/forum
display.php?f=270

Ubuntu Youth

T

he other day I came across
Tux Math from Tux4kids.
It is an educational game
which teaches the kids to
calculate. The various levels start
with learning the numbers,
additions up to 10, 20 100, same
with subtraction, multiplication,
and division. My 7-year-old son
really enjoys the game, so I started
to look for more.
This brings me to the topic of
this email. It would be nice to have
a column for kids. Not only with
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educational games, but also secure
access to the Internet. I remember
an article about proxying the
Internet access for kids. I will have
to check this when the time comes.
I would greatly appreciate such
a column, perhaps spontaneously;
I'm not looking for this kind of
software, but when I read about it I
think it could interest my sons.
Frank Bommeli

Thanks for the idea Frank. We
usedto have an Ubuntu Youth
column a couple ofyears ago, but
the writer vanished. Anyone out
there want to restart Ubuntu Youth,
or start Ubuntu Kids? - Ed.

Primary Age

Y

ou asked what we
thought was the average
age of Ubuntu users was.
On reflection, reading
your letters, I would say possibly
late primary school age to early
secondary school age.
I derive this information from
the churlish and petty complaints
from people who are totally unable

to grasp a new technology such as
Unity.
Now I thought it was people of
my age (in my seventies) who were
unable to adapt to change and to
adapt to new ideas with
technology, rather than young
children who are supposed to work
it out quicker than us old farts?

with 8gigs of RAM and three
separate 1TB hard drives (two of
them external).
Andrew Ampers Taylor

MySQL to SQLite

type of Database as well as
spreadsheets or XML. Of course
MySQL and SQLite are among the
options. I am currently using the
tool in Ubuntu 11.10 and Windows
XP. Maybe at some point I could
write a how-to article about ETLing.

Rolland J. Sovarszki
I am not sure if this is the right
place to write to you regarding a
I took to Unity as a duck takes to comment on one of the articles
Thanks for the info Rolland, I've
water. And, I have had no problems from Full Circle Magazine, Issue55. passedit along to Greg. And, yes, do
with it. This is perhaps why I find it
feel free to write an article about
The article is called How-To
so difficult to believe the younger
Program in Pyton - Part 29, written ETL-ing. - Ed
amongst us cannot grasp it?
by Greg Walters. He states there:
"A little while ago, I was askedto
LTS
So what does an old geezer like convert a MySQL database to
me use Linux for? Not just for
SQLite. Looking aroundthe web for
n FCM#54, you quoted PC
browsing the web and writing
a quick andeasy (andfree) solution, I
World as saying, "Precise
occasional letters. I use it for
foundnothing that workedwith the
Pangolin ... will be Ubuntu's
running a newspaper in Norf
current version ofMySQL for me. "
fourth Long Term Support
Lunnon.
(LTS) release, with a full three years
This is not true. I am a Business
of support."
We use it for writing articles, for Intelligence developer and on a
editing photographs, and for
daily bases I use ETL tools. I am
In fact, starting with 12.04,
sorting out our website using the
working with Pentaho Data
desktop LTS releases will be
new version of Drupal content
Integration Tool (Kettle) CE
supported for five years. There are
management software.
(Community edition)
some limitations, though;
(http://kettle.pentaho.com/). It is a hardware updates will be for the
I use 11.10 in my Netbook
full open source product and it is
first two years only.
already, and will change to 11.10
very mature. It has the ability to
on my business desktop as soon as transport/transform data from any
Paddy Landau
it rolls out. You just would not
type of source to any other type of
believe the number of programs I
source. The sources can be any
use on my 64-bit home desktop -

I
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If you would like to submit a puzzle for publication, please
email it to: letters@fullcirclemagazine.org . Solutions are on
the second last page of this issue. No peeking!

A Crossword Puzzle of Bash Commands
by Dave Mawdsley

The solution to all the puzzles is on the second
last page of this issue. No peeking!
full circle magazine #56
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CRYPTIC CROSSWORD

Across
1
The center of the Linux OS (6)
3
Bootloader's food (4)
6
Precise scaly anteater which we'll get to see in
April (8)
7
It's not UNIX! (3)
8/8D Lively rabbit with horns widely seen a couple of
years back (6,9)
11/19 Intellectual Timon? (8,7)
16
Several universes? Just a repository (10)
17
Open source software is not free ____. (4)
19
See 11
20
A lightweight 3D design and animation tool (7)

by Ilavenil Thirumavalavan

Down
1
If you don't like Gnome, you just might like this (3)
2
Cat-like, sharp-eyed, lucid! (4)
4
A desktop with integrity (5)
5
OS initiator and kernel developer in violin user? (5)
7
It's free, but it gives Photoshop a run for its
money (4)
8
See 8 Across
9
Our own little penguin (3)
10
A Linux user isn't worried about it (5)
12
Repository of everything (8)
13
Garden ornament or desktop environment? (5)
14
The OS Ubuntu is based on (6)
15
Enhance multi-window management using this
Japanese folding screen (5)
18
Use LEXAR to flip this (3)
The solution to all the puzzles is on the second
last page of this issue. No peeking!
full circle magazine #56

46

contents ^

Q&A

If you have Ubuntu-related questions, email them to:
questions@fullcirclemagazine.org, and Gord will answer them in a future
issue. Please include as much information as you can about your problem.

Compiled by Gord Campbell

Q

How can I customize
Gnome Classic?

A

There's a lengthy howto here:
http://ubuntuforums.org
/showthread.php?t=1886

799

Q

I have a system based on
the AMD Athlon
Processor 2650e, and I
installed the Nvidia
graphic driver. When I start a
second application, performance is
terrible!

A

Remove the Nvidia
graphic driver. Another
user with a similar
problem discovered that
Ubuntu automagically installed the
older 173 nvidia drivers, and
switching to a later driver caused
very poor performance with
multiple applications.

Q

I have a .mkv file I
needed to convert for an
ipad. When I use default
values with ffmpeg, it
gives an error message.

A

(Thanks to andrew.46 in
the Ubuntu Forums) Try
this command:

ffmpeg i
/media/Warehouse/Movies/input
.mkv vcodec copy acodec
libfaac ar 44100 ab 128k
~/output.mp4

For this to succeed you will
need to follow part C of
FakeOutdoorsman's guide, to allow
aac encoding with libfaac. This will
set up ffmpeg with the required
codecs.
http://ubuntuforums.org/showthre
ad.php?t=1117283

Q

I'm trying to make a
bootable USB with
unetbootin, the USB has
been formatted with
NTFS as that is required. The
problem is that the USB doesn't
full circle magazine #56

show up in unetbootin (I can mount
it and see it in fdisk).

A

Go to the top-right
corner and click System
Settings. Select
From
"Removable Media."
http://unetbootin.source Check the box, "Never prompt or
forge.net/ "If your USB
start programs on media
drive doesn't show up,
insertion."
reformat it as FAT32." (see image)

A
Q

What are some of
the alternatives to
Unity in Ubuntu
11.10?

A

See this web page:
http://maketecheas
ier.com/5alternatives-tounity-in-ubuntuoneiric/2011/10/27

Q

I'm using 11.10 with
Unity. When I load a
CD, its contents
open in the file
manager, and the CD also
appears in the launcher. I
want it to appear only in the
launcher.
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Q

In Oneiric, I close the lid
on my laptop, and it
Suspends. I open it, and it
asks for my password. I
just want it to resume, without
asking for my password.

A

Run this command:

gsettings set
org.gnome.desktop.lockdown
disablelockscreen 'true'

Q

Any other suggestions
for tweaking Oneiric?

A

http://www.webupd8.or
g/2011/10/things-totweak-after-installingubuntu.html

Q

I'm trying to connect to
my headless server with
SSH using "authorized
keys," but it doesn't work,
because my home folder is
encrypted.

A

This page describes a
workaround:
https://help.ubuntu.com
/community/SSH/OpenS
SH/Keys#Troubleshooting

Q

In Ubuntu 11.04 or 11.10,
the backlight doesn't
come on, on my laptop. It
has a Mobile Intel 4 Series
Express Chipset Family graphics
controller. An external monitor
works fine.

A

See this web page:
http://linux-on-aceraspire5732z.blogspot.com/201
1/06/backlight-workaround-forlinux-mint-11.html

the bios to allow a non-EFI boot,
and install again.

bedded

Q

I'm trying to learn how to
use a utility like scandisc,
is there one I can
download from the
software center?

Is there any englisharabic and arabic-english
dictionary?

A

(Thanks to yoramdavid
in the Ubuntu Forums)
You can use GoldenDict
with babylon.bgl files.
(all free). Goldendict is in the
repositories, and you can Google
babylon.bgl.

Q

How can I create a
custom login screen for
Ubuntu 11.10?

A

To change the
I installed Ubuntu 11.10
background:
in a dual-boot on a
http://www.omgubuntu.
Thinkpad X120. The
co.uk/2011/09/toolinstall went smoothly, but change-lightdm-wallpaper-ubuntuwhen I reboot, the system boots
11-10/
straight into Windows without a
Grub menu.
For an amusing, extreme
example of changing the login
(Thanks to
screen:
substanceneil in the
http://www.youtube.com/watch?v=
Ubuntu Forums) Change f8nm4NpaVXE&feature=player_em

Q

A
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Q

A

The system will run this
automatically about
every 30 boots.

Q

I replaced my ATI Radeon
HD 4770 video card with
an Nvidia GTX 560 Ti.
When I boot Ubuntu
10.10 64-bit, it goes straight to a
command line, with no GUI.

A

(Thanks to papibe and
emilywind in the Ubuntu
Forums) First, rename
the Xorg configuration
file with this command:
sudo mv /etc/X11/xorg.conf
/etc/X11/xorg.conf.ATI

Then reboot, and you should
have a GUI. Since your video card is
so new, you will need to get a video
driver from an unusual repository.
Run this command:
contents ^

Q&A
running a distro which was
produced by one person.

sudo addaptrepository
ppa:ubuntuxswat/xupdates

Then this one:
sudo aptget update

Then you can search for nvidiagraphics-drivers. At the moment,
the latest driver is version
285.05.09.

Tips and Techniques
A Retro Distro

S

ome people don't like the
way Ubuntu's user
interface has changed in
recent versions, and a
person from Rome, known as
lucazade in the Ubuntu Forums,
has done something about it.
The Italian has produced a
distro called FreezyLinux. It's
based on Ubuntu 11.10 and Gnome
3.2. As I am writing this, it's still
classified as a beta. It's too big for a
CD, but might fit on a 1 GB flash
drive. All those things may change
by the time you read this. The
home page is:
http://freezylinux.altervista.org/

What has lucazade produced?
There's a single panel on the
bottom of the screen, with
hierarchical menus, just like Ubuntu
had before Unity came into the
picture. Windows have minimize,
maximize and close
buttons on the top-right.
The distro includes
Chromium as its web
browser, Rhythmbox for
playing music, Synaptic
for installing programs,
Dropbox for cloud
storage and GIMP for
editing images. Cheese
webcam booth is
included.

normal under Freezy. This got a
little better when I installed
Fancontrol from the Ubuntu
repositories, but it was still hot.
The distro includes no games. I'm
ever so slightly nervous about

Even though Freezy _looks_ like
older versions of Ubuntu, it's based
on the latest Gnome. That means it
won't run those old applets, among
other things. Still, if you want to go
on a trip down memory lane, it's an
option you can consider.

Upon loading, Freezy
takes 370 MB less
memory than Ubuntu
11.10 on my laptop. I have
only run it from a
persistent flash drive, but
it seems to be pretty
snappy.
The downsides? My
laptop runs hotter than
full circle magazine #56
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UBUNTU GAMES

H

Multiwinia

Written by Riku Järvinen

i everybody! The game
for review this month is
Multiwinia
(http://goo.gl/yaV0B), a
real-time strategy experience by
Introversion. Maybe you’ve heard
about Darwinia (an RTS published
back in 2005); this is the sequel,
introducing new gaming ideas.

Background Story &
Gameplay
The world of Darwinia is a
virtual theme park running inside a
computer network. It was created
by a computer genius called Dr.
Sepulveda, who combined decades
worth of genetic research to create
sentient, evolving life forms: the
Darwinians. In the original game,
these little two-dimensional
fellows are overrun by an evil
computer virus, taking over the
main systems and forcing
Darwinians to face evident doom.
With some help from Sepulveda,
the viral infection is beaten and
status quo ultimately restored.
However, as time flies,
Darwinians evolve into more

independent and aggressive
beings. They form tribes and begin
to fight over the land’s resources.
In this new era, they’re called
Multiwinians, a far cry from the
peaceful, law-abiding entities they
once were. Great battles rage all
full circle magazine #56

over Darwinia, consuming many
digital lives and creating fear...
Still, Multiwinians cannot
manage by themselves, and they
need someone to guide their
actions. In addition to simple
annihilation, the game has
50

strategic battle modes such as
Capture The Statue and Rocket
Riot, in which you need to focus
also on protecting your assets and
planning some sort of a strategy
for different phases of the game. I
find this appealing since too many
of today’s RTS’s simply feature the
contents ^

UBUNTU GAMES - MULTIWINIA
armament phase and the all-out
attack, leaving little in between.
Nevertheless, there could be some
improvement, because many
scenarios just end up in a huge
demolition match, no matter what
the actual mission is.
I very much liked the fact that
Multiwinia is easy to dig into.
Controls are standard, and there
are two tutorials covering most of
the essential feats. Anyways, the
real trick is to be fast: scenarios
usually last less than ten minutes,

and reinforcement troops need to
be deployed at once when they are
available. Battle efficiency can be
enhanced by creating formations
of troops led by officers, building
gun turrets, using transportation
vehicles, and taking advantage of
powerful custom weaponry.

experienced a noticeable slowdown on my Ubuntu 11.10 laptop
(2.7 GHz Core i7, Radeon 6470 1
GB, 4 GB DDR3, SSD), playing with
the highest settings on an external
27” Full HD screen and 1080p
resolution. With lower settings
there was no problem.

Since Multiwinia was originally
released in 2008, the minimum
requirements are not too bad: a 2.0
GHz processor, 512 MB RAM, 32
MB video card, and 60 MB of disk
space. Yet, surprisingly, I

Conclusions
While Multiwinia is certainly
noticeable among RTS games, and
has a characteristic idea for
gameplay, it loses much in its

repetitive nature. Participating in
fierce, lightning-fast battles of
hundreds of troops is cool, but,
after a few days of intensive
gaming, one likely loses interest. I
had high hopes for the multiplayer,
but the servers are not very active.
Summing it up, Multiwinia is
probably a good game when
played once in a while, hacking
through a couple of scenarios in a
burst.
Good:
-easy to learn; challenging to
master; intuitive set of basic
controls
-nice background story
-decent gameplay - even on a lowend machine
Bad:
-repetitive nature of things
regardless of the game mode
-inactive servers for multiplayer
-the tutorial is not as thorough as
in Darwinia

Points: 7 / 10

Riku Järvinen (rierjarv) is a CS major
student from Finland who delves into
the Linux and Open Source gaming
world once in a while.
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UBUNTU GAMES

Bobby

Written by Jennifer Roger

B

obby is a physics-based
space adventure
developed by Nooskewl
Games. Your goal is to
maneuver Bobby the Bullet
throughout each level to knock the
green balls into the red spiral.
Once you eliminate all of the balls,
the red portal turns green, inviting
you to warp to the next zone. You
are awarded stars after completing
each level, and are graded on how
quickly you complete them.
The controls are quite simple –
change directions with the arrow
keys, and propel Bobby using the
space bar. Although the game

mechanics are simple, the real
challenge lies in the precision and
timing. One over-zealous push of
the space bar will send him flying
into the portal, thus restarting the
level if the green balls aren't
cleared yet!
Aesthetically, Bobby is fun and
vivid with plenty of arcade
nostalgia. The graphics are clear
and smooth, and there were no
noticeable glitches or frame rate
issues when tested on Oneiric
11.10. The music and sound effects
are also of good quality, and set
the mood for a nice session of
classic gaming. The premise is

simple – knock the green balls into
the portal to advance to the next
stage. But the simplicity of the
game is what makes it so charming
and addicting.
You can download a free demo
from Nooskewl's website, or
purchase all 75 levels at
https://www.nooskewl.com/buy_b
obby.html for only $0.99. Bobby is
also available for purchase in the
Ubuntu Software Center.
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Good:
• fun and addictive
• soundtrack
Bad:
• can be frustrating
• some over-sensitive controls

Score: 9/10

Jeniffer Rogers ..........
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MY DESKTOP

Your chance to show the world your desktop or PC. Email your screenshots and
photos to: misc@fullcirclemagazine.org and include a brief paragraph about your
desktop, your PC's specs and any other interesting tidbits about your setup.

This is the desktop I currently have on the Linux Mint
installation on my laptop. It's the standard desktop
background, complete with several icons for the programs I
use most. At the bottom you see Cairo dock with Mint-style
icons, sorted in launchers, applets, and running applications.

This is Ubuntu 11.10, 64-bit, running on my EeePC 1005PX with
Intel Atom N450 @ 1.6GHz and 2GB RAM. I'm using GnomeShell instead of Unity. The theme Ambiance Blue is installed,
and the icon theme is Faenza. Gnome Shell Weather Extension
is installed as per the following guide, which is also the
configuration tool for all of this desktop; gnome-tweak-tools:
http://www.webupd8.org/2011/10/install-gnome-shellweather-extension.html#more. My wallpaper is a photo I took
from Gothenburg City on a summer night.

My system is a Samsung R730 17.3" laptop with a P6100 Core
2 Duo CPU, 4GB RAM and 500GB hard disk. The monitor is
16:9 with 1600x900 pixels.
It's simple but nice, just like me.
DeMus

Barbara Hohensee
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MY DESKTOP

My computer is an Intel Core i7 2600 (4 Cores) @ 3.4 GHz, and 4
GB of RAM. I'm running Kubuntu 11.10. The plasma theme is
the default Air theme, and the colour scheme is "Penguin".
What makes my desktop attractive (to me) is the widget style,
Oxygen Transparent, configured with a hint of transparency.

This is my desktop.
I am a student and also a novice to Ubuntu. My desktop
looks so cool in a green and black combo. I am a Tamil. Our
region always looks so cool with green paddies, so I choose
this paddy wallpaper for my desk. I added some screenlets,
and Cairo Dock increases the charm.

Also of note is the fact that I've given all the folders in my
Home directory custom icons. Most of them are from the Dark
Glass Reworked Icon set. Despite being mostly for aesthetics, I
find it surprisingly productive. It's easy to find my usual folders.
And when I put something temporary in my Home Directory,
the plain blue stands out, and I'm more inclined to work
through the file/folder and delete it, or relocate to its
permanent residence inside one of the other folders.

My cpu is a dual core @1.6 GHz, 1 GB RAM.
Manimaran G

Stephan Goosen
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MY DESKTOP - BONUS

I

nside this cheap Asus Vento
A2 chassis is where the Full
Circle magic happens.

Inside it beats an Intel Core 2
Quad CPU seated on an Abit IP35
Pro XE motherboard which has a
total of 4GB of RAM. I have two old
hard drives, a 55GB one which I
rarely use, and the other is 114GB

which I use for
backups. My main
hard drive, which sits on my desk, is
1TB. It holds the entire archive of
FCM in both Scribus, and PDF,
format. But, then again, so does
the Ubuntu wiki.
Display is driven by an Nvidia
GeForce 9400 GT. Out of the
picture is my Netgear router which
full circle magazine #56

gives me wireless
Internet throughout the
house, handy for all my
other widgets and
gadgets.
And yes, I do have a hard drive
hanging out the side of my PC all
the time.
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Feel free to send in photos of
your PC to
misc@fullcirclemagazine.org.
Ronnie
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Full Circle Team

HOW TO CONTRIBUTE

Editor - Ronnie Tucker

We are always looking for new articles to include in Full Circle. For article
guidelines, ideas, and for issue translation, please see our wiki:
http://wiki.ubuntu.com/UbuntuMagazine
Please email your articles to: articles@fullcirclemagazine.org

ronnie@fullcirclemagazine.org
Webmaster - Rob Kerfia
admin@fullcirclemagazine.org
Comms Mgr - Robert Clipsham
mrmonday@fullcirclemagazine.org
Podcast - Robin Catling
podcast@fullcirclemagazine.org

Editing & Proofreading
If you would like to submit news , email it to: news@fullcirclemagazine.org
Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org

Questions for Q&A should go to: questions@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org

Mike Kennedy
Lucas Westermann
Gord Campbell

Our thanks go out to Canonical, the
many translation teams around the
world and to Thorsten Wilms for the
current Full Circle logo.

... or you can visit our forum via: www.fullcirclemagazine.org
Deadline for Issue #57:
Sunday 08th Jan. 2012.
Release date for issue #57:
Friday 27th Jan. 2012.

FULL CIRCLE NEEDS YOU!
A magazine isn't a magazine without articles and Full Circle is no exception. We need
your Opinions, Desktops and Stories. We also need Reviews (games, apps &
hardware), How-To articles (on any K/X/Ubuntu subject) and any questions, or
suggestions, you may have.
Send them to: articles@fullcirclemagazine.org
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